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This document, the Epiphan web site, and the information contained therein, including but not limited to the text, 

videos and images as well as Epiphan System Inc.’s trademarks, trade names and logos are the property of Epiphan 

System s Inc. and its affiliates and licensors, and are protected from unauthorized copying and dissemination by 

Canadian copyright  law, United States copyright  law, trademark law, international conventions and other  

intellectual property laws. 

Epiphan, Epiphan Video, Epiphan System s, Epiphan System s Inc., and Epiphan logos are trademarks or registered 

trademarks of Epiphan System s Inc., in certain countries. All Epiphan product names and logos are trademarks 

or 

registered trademarks of Epiphan. All other company and product names and logos may be trademarks or 

registered trademarks of their respective owners in certain countries. For additional terms and conditions, refer to 

sections at 

the end of document. 

 

Copyright © 2018 Epiphan System s Inc. All Rights Reserved. 

 

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE 

INFORMATION PACKET OR PRODUCT INSTALLATION SOFTWARE PACKAGE THAT SHIPPED WITH THE PRODUCT AND 

ARE INCORPORATED HEREIN BY REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSES OR LIMITED 

WARRANTY, CONTACT YOUR EPIPHAN REPRESENTATIVE FOR A COPY. 

PRODUCT DESCRIPTIONS AND SPECIFICATIONS REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO 

CHANGE WITHOUT NOTICE. EPIPHAN PERIODICALLY ADDS OR UPDATES THE INFORMATION AND DOCUMENTS ON 

ITS WEB SITE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION AND RECOMMENDATIONS ARE BELIEVED TO BE 

ACCURATE AT TIME OF WRITING BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. 

USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS. 

LIMITATION OF LIABILITY 

 

UNDER NO CIRCUMSTANCES SHALL EPIPHAN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, CONSEQUENTIAL, 

EXEMPLARY OR OTHER INDIRECT DAMAGES THAT RESULT FROM THE USE OF, OR THE INABILITY TO USE, THIS 

PRODUCT OR THE INFORMATION CONTAINED IN THIS DOCUMENT OR PROVIDED ON EPIPHAN’S WEB SITE, EVEN IF 

EPIPHAN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL EPIPHAN’S TOTAL 

LIABILITY TO YOU FOR ALL DAMAGES, LOSSES, AND CAUSES OF ACTION RESULTING FROM YOUR USE OF THIS 

PRODUCT, WHETHER IN CONTRACT, TORT (INCLUDING, BUT NOT LIMITED TO, NEGLIGENCE) OR OTHERWISE, EXCEED 

THE AMOUNTS YOU PAID TO EPIPHAN DURING THE MOST RECENT THREE-MONTH PERIOD IN CONNECTION WITH 
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AMOUNTS WHICH YOU PAID FOR USING THIS PRODUCT. 

INFORMATION AND DOCUMENTS, INCLUDING PRODUCT SPECIFICATIONS, PROVIDED IN THIS DOCUMENT OR THE 

EPIPHAN WEB SITE ARE PROVIDED “AS IS”. SPECIFICALLY, BUT NOT WITHOUT LIMITATION, EPIPHAN DOES NOT 

WARRANT THAT: (i) THE INFORMATION IS CORRECT, ACCURATE, RELIABLE OR COMPLETE; (ii) THE FUNCTIONS 

CONTAINED ON THE EPIPHAN WEB SITE WILL BE UNINTERRUPTED OR ERROR-FREE; (iii) DEFECTS WILL BE 

CORRECTED, OR (iv) THIS WEB SITE OR THE SERVER(S) THAT MAKES IT AVAILABLE ARE FREE OF VIRUSES OR OTHER 

HARMFUL COMPONENTS. EPIPHAN SPECIFICALLY DISCLAIMS ALL REPRESENTATIONS, WARRANTIES, AND 

CONDITIONS, EITHER EXPRESS, IMPLIED, STATUTORY, BY USAGE OF TRADE OR OTHERWISE INCLUDING BUT NOT 

LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, TITLE, SATISFACTORY QUALITY 

OR FITNESS FOR A PARTICULAR PURPOSE. 
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Epiphan Video（「Epiphan」）では、製品の機能と品質を重視しています。Epiphanでは製品が利用者

の期待を超えるようあらゆる努力をします。 

 

 

商品フィードバック 

あなたのフィードバックは重要です！お客様のニーズに対応するために、継続的に製品を強化するよう努め

ています。製品の改善案などありましたら、 info@epiphan.comまでメールをお送りください。 

 

 

仕様 

Epiphan WebサイトのSDI2USB3.0製品ページにアクセスして、SDI2USB3.0に関する最新の製品仕様と追加

情報を入手してください。 

アルゴHP：https://www.argocorp.com/grabber/eizou/Epiphan/SDI2USB3.html 

 

 

保証 

すべてのEpiphan Systems製品には、購入日から1年間、無償保証（センドバック方式）が付いています。 

 

 

技術サポート 

Epiphanの製品は、専門のサポートチームによって支えられています。製品に問題がある場合は、システ

ムの詳細を収集し、次の方法でEpiphan社のチームに連絡してください。（何かありましたら、アルゴま

でご連絡ください。） 

⚫ Eメール support@epiphan.com （アルゴ：argo@argocorp.com） 

⚫ サポートサイトリンク経由でのライブチャットhttps://www.epiphan.com/support/ 

mailto:support@epiphan.com
https://www.epiphan.com/support
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⚫ TEL 1-877-599-6581 、+1-613-599-6581 （アルゴ：06-6339-3366） 

 

問題についてできるだけ多くの情報を含めご連絡ください 

⚫ Problem description問題の内容 

⚫ 映像、音声ソースの詳細（どのような信号か、接続、解像度、リフレッシュレートなど） 

⚫ シリアル番号（製品裏面記載） 

⚫ ファームウェアバージョン 

⚫ LEDライトの状況 

 

Copyright © 2018 Epiphan System s Inc. All Rights Reserved. 
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SDI2USB3.0のファームウェアアップデート3.30.7.8は、安定性とパフォーマンス強化を含むメンテナンスリリ

ースです。最新ファームウェアバージョンでの改善をご希望の際はアップデートを行ってください。（基本的に、

Epiphan社では最新ファームウェアバージョンでのサポートとなります） 

重要事項: このファームウェアアップデート3.30.7.8は、SDI2USB3.0用のWindows32ビットドライバーバー

ジョンを含む最終アップデートです 

 

Web broadcasting demo 機能の削除 

Web broadcasting demo機能はEpiphan Capture Toolから削除され、アイコンはツールバーに表示されなく

なりました。 

 

推奨ビデオコーデック (2019年３月) 

このユーザーガイドでは、クイックスタートで推奨されているffdshowビデオコーデックをK-Lite（メガ）

ビデオコーデックパックのx264vfwコーデックに置き換えるための更新が行われました。 

 

ユーザーガイドで更新されたFCCコンプライアンスステートメント 

 (2020年４月) 

カナダのイノベーション、科学、経済開発に関するISED規則のICES-003のコンプライアンスステートメント

がこのユーザーガイドに追加されました。また、FCCの注意事項が追加されました。 
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Start here 
 

 

SDI2USB 3.0. ユーザーガイドのこのセクションのトピックをご覧いただくと、SDI2USB3.0を素早くご利用い

ただけます。 

 

付属品を確認し、get a system overview in SDI2USB 3.0とは?で概要を、システム要件 でPCの仕様を満た

していることを確認し、クイックスタートでビデオグラバーをインストールすると、すぐにご利用いただ

けます。 
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実際には、転送速度はUSB負荷やハードウェア構成などの要因に依存します。 

 

SDI2USB 3.0とは? 

SDI2USB 3.0™はEpiphanのプロフェッショナルシリーズの外部SDI (3G-SDI、HD-SDI、SD-SDI)ビデオグ

ラバーです。SDIビデオソースから画像や映像をキャプチャし、USB3.0ポートへの接続を介してPCまたは

ワークステーションでデジタイズします。 

 

ビデオキャプチャワークステーションは、結果として得られる非圧縮の画像および映像を記録および/または

ストリーミングできます。 Windowsでは、音声キャプチャと映像キャプチャの両方がSDIソースでサポート

されています。 Epiphan Videoキャプチャテクノロジーは、小型でポータブルなSDI2USB3.0をコンピュータ

のUSB3.0ポートに直接接続することを可能にしました。PCIスロットを備えた大型ワークステーションは必

要ありません。 

 

SDI2USB 3.0は3G-SDI、HD-SDI、SD-SDIソースから映像と音声をキャプチャします。より大きなファイル

をより高速で転送するため最大5.0（Gbits / s）の速度で非圧縮データを転送できるテクノロジーである

USB3.0をサポートします。これはUSB2.0の約10倍の速度です。 
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SDI2USB 3.0は用途が広く、複数のワークステーション構成で使用できます。USB 2.0接続と下位互換性が

ありますが、USB 2.0を使用すると、フレームレートが低下してビデオが転送されます。 

付属のEpiphan Capture Toolを使用して、SDI2USB3.0はRGB-24ビットカラーでフル1080pHDを30フレー

ム/秒でキャプチャし、最大1920×1080の解像度をサポートします。 YUV 4：2：0クロマサブサンプリング

を備えたWindows Media Encoderなどのサードパーティソフトウェアを使用する場合、1080pビデオがキャ

プチャされ、毎秒60フレームを記録されました。すべての場合において、SDIビデオ信号はRGB 24ビットカ

ラーでキャプチャされ、YUV 4：2：0クロマサブサンプリングの場合、この新しい色空間に変換されること

に注意してください。 

サードパーティのアプリケーションを使用してキャプチャ、記録、ストリーミングするときにフレームレー

トを最大化する方法の詳細については、EpiphanのWebサイトにあるHow to Record Video using Window 

Media Encoder を参照してください。 

入力ポートに加えて、SDI2USB 3.0はモニタリングに使用できるSDI出力ポートを提供します。以下の例で

は、出力ポートに接続されたモニターを使用して、入力信号をモニターし、必要に応じてすばやく調整する

ことができます。 

 

SDI2USB 3.0ビデオグラバーは、WindowsのDirectShowと完全に互換性があります。つまり、キャプチャ、

記録、ストリーミングのために、さまざまなサードパーティアプリケーションで使用できます。 

SDI2USB 3.0は、Epiphanのビデオ、オーディオ信号キャプチャ製品ラインナップの一部です。その他の

Epiphan製のビデオ信号キャプチャ製品の詳細については、Epiphan Video WebサイトのUSB Video 

Grabbers ページ（アルゴＨＰ：https://www.argocorp.com/grabber/eizou/dpgrab.html）をご参照くださ

い。 

https://www.epiphan.com/solutions/record-video-using-windows-media-encoder-windows-8/
https://www.epiphan.com/solutions/record-video-using-windows-media-encoder-windows-8/
https://www.epiphan.com/products/compare-usb-video-grabbers/
https://www.epiphan.com/products/compare-usb-video-grabbers/
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付属品 

SDI2USB 3.0には以下の付属品が含まれます 

1. SDI2USB 3.0 本体 

2. 3G準拠のSDIケーブル ×１ 

3. USB 3.0ケーブル ×１ 

 

Table 1付属のケーブルの説明（識別用の画像のみ、色と外観は異なる場合があります） 
 

Image Name Description 
 

 

 

 
SDI ケーブル 

 

 
SDIソースをビデオグラバーに接続する 

 

 

 

 

 

 

USB 3.0 ケーブル 

 

 

 

ビデオグラバーとキャプチャワークステーシ

ョンやPCを接続する高速転送ケーブル 
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3.30.2以降のSDI2USB3.0用のEpiphanドライバは、SHA-2署名を使用しており、これはWindows 

XP、Windows Vistaではサポートされていません。 

 

システム要件 

システム要件はコンピュータがEpiphanビデオグラバーと連携するために必要な技術的要素です。

SDI2USB3.0を使用するためにシステム要件は次の通りです。 

 

 

ビデオソース 

3G-SDI、HD-SDI、SD-SDIソース。 

（SDI2USB3.0はHDCP暗号化ソースからキャプチ

ャできません） 

 

 

 

 

ビデオキャプチャワークステーション 

次の機能を備えたコンピュータ(ラップトップ/ デス

クトップ/その他の形式): 

⚫ SuperSpeed操作用の互換性のある

USB3.0ホストコントローラー (推奨 Intel 

® USB 3.0 eXtensible Host Controller);  

または  

⚫ USB 2.0コントローラー 

ビデオキャプチャワークステーションOS  

Windows 10 

RAM 推奨最小値: 4 GB 

Available hard disk space 16 GB (32-bit OS) または 20 GB (64-bit OS) 
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クイックスタート 

このクイックスタートを使用して、WindowsキャプチャワークステーションでSDI2USB3.0をすばやく起動

して実行します。これらの手順を使用して、ファームウェアアップデートをインストールすることもできま

す。  

ご利用前に: 

⚫ 必要なケーブル、コンポーネント、アダプタ（必要な場合）をすべて用意します。参照 付属品 

⚫ キャプチャワークステーションがSystem requirementsを満たしていることを確認します。 

⚫ カメラ、PC、タブレット、電話などのビデオソースを用意し、それらの信号がHDCPで保護されて

いないことを確認します。Windowsシステムの場合、音声と映像が同じケーブルで出力されている

ことを確認します。 

⚫ ドライバをダウンロードするためにインターネットアクセスがあるか確認します。 

⚫ キャプチャワークステーションの管理者権限を確認します。 

 

ビデオグラバードライバのインストール 

キャプチャワークステーションにビデオグラバーを接続する前にこちらの手順を完了してください。 

1. (オプションとして)もし接続している場合は、 キャプチャワークステーションからビデオグラバーを

切断する 

2. 管理者権限を持つアカウントでキャプチャワークステーションにログインする。ワークステー

ションがドメイン上にある場合は、ドメインのアカウントではなく、ワークステーションのロ

ーカル管理者アカウントにログインしていることを確認してください。 

3. キャプチャワークステーションでWebブラウザを使用して、Epiphan ソフトウェアダウンロードサイ

ト＞ Epiphan  キャプチャユニット/ボード ＞ キャプチャソフトウェア Epiphan Capture Toolにある

オペレーティングシステムに適切なドライバをダウンロードする 

https://www.argocorp.com/grabber/eizou/Epiphan/Epiphan_software.html
https://www.argocorp.com/grabber/eizou/Epiphan/Epiphan_software.html
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Windows 10オペレーティングシステムの場合、必要に応じて、64ビットまたは32ビットの

いずれかのドライバを選択します。必要なドライバのバージョンがわからない場合は、こ

のマイクロソフトサポート技術情報の記事 

https://support.microsoft.com/enus/kb/827218を参照してください。 

 

インストーラーが管理者として実行されている場合でも、Windowsドメインから

セキュリティアクセス許可を継承しているコンピュータのインストールが失敗す

る場合があります。その場合は、ご所属のITチームにインストールのサポートを

依頼してください。 

 

4. ダウンロードが完了したら、ダウンロード先のフォルダを開く 

5. (オプションとして) 不要なウィンドウを全て閉じ、ワークステーションで実行されているプログ

ラムをシャットダウンする。厳重に制限されたセキュリティソフトウェアは、デバイスドライバ

のインストールをブロックする可能性があることに注意してください。その場合、キャプチャワ

ークステーションでドライバの更新を許可する手順については、ご所属のシステム管理者に相談

してください。 

6. すべてのドライバファイルを展開し、WindowsワークステーションにドライバとEpiphan 

Capture Toolをインストールする 

a. .zipファイルを右クリックし、すべて展開する 

b. 展開したファイルフォルダからsetup.exeを右クリックし、管理者として実行を選択する 

c. Click Installをクリックしプロンプトに従ってドライバをインストールする。The 

Epiphan Capture Toolはドライバと同時にインストールされます。 

7. インストールが完了したら、キャプチャワークステーションを再起動し、ビデオグラバーを接

続する 
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Windows用のビデオコーデックをインストールし、ビデオ圧縮

オプションを設定する 

Windowsオペレーティングシステムの場合、K-Lite（Mega）ビデオコーデックパックをインストールするこ

とをお勧めします。このコーデックパックは、Epiphan Capture Toolを使用して映像を録画するためのビデ

オ圧縮オプションを追加します。圧縮せずに録画すると、特に高解像度で録画する場合に大量のディスク領

域が消費されるため、お勧めしません。メーカーではテストの結果、このコーデックパックのコーデック

x264vfwが、ビデオグラバーでの使用に適しているとしています。 

K-Lite（Mega）ビデオコーデックパックをWindowsキャプチャワークステーションにインストールするには: 

1. 管理者権限を持つアカウントを使用してキャプチャワークステーションにログインし、Epiphan 

Capture Toolを起動する 

2. ToolsメニューからOptions...を選択し、DisplayタブのDisplay formatがRGB 24 bits per pixel（初期設定）

に設定されていることを確認する 

3. キャプチャワークステーションでWebブラウザを使用して、K-Lite（Mega version）ビデオコーデッ

クパックをダウンロードする（32ビットと64ビットバージョンが含まれています） 

⚫ K-Lite (Mega) video codec pack 

注）K-Lite Codec Pack MegaとK-Lite Codec Packは異なります。上記リンクページのServer１、 

Server２、Server３のいずれかをダウンロードし、インストールしてください。同時に異なるもの 

をインストールしないでください。 

 

4. ダウンロードした実行可能ファイルを見つけ、ファイルをダブルクリックし、プロンプトに従って、

WindowsバージョンのK-Lite（Mega）コーデックパックをインストールする。Normalのインストー

ルモードを使用し、初期設定のオプションを受け入れます。コーデックパックのインストールが完了

したら、Finishをクリックします。 

5. Epiphan Capture ToolのToolsメニューからOptions...を選択し、Recordingタブをクリックする 

https://codecguide.com/download_k-lite_codec_pack_mega.htm
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最も一般的なインストールではビデオ圧縮コーデックの初期設定を使用します。ビデオ

圧縮パラメータを設定する必要はありません。 

6. Recordingタブで、Record asフィールドをVideoに設定し、Select Codecをクリックする 

7. Compressorドロップダウンで、x264vfw - H.264/MPEG-4 AVC compressionを選択し、OKをクリック

する 

 

 

 

8. 変更を保存するためApplyをクリックする。すべての設定を終えたらOKをクリックします。 

 

ビデオグラバーとビデオソースの接続 

ドライバとビデオコーデックのインストールが完了すると、キャプチャを開始する準備が整います。以下

の手順では、ビデオソースをグラバーに接続し、次にグラバーをワークステーションに接続するように記

載しておりますが、ビデオソースとビデオグラバーは任意の順序で接続できます。 

1. ビデオソースをビデオグラバーのSDI INポートに接続する （必要に応じて、アダプターまたは適切

なコンバーターケーブルを使用してください。） 
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2. 付属のUSB3.0ケーブルをビデオグラバーの下部に接続する 
 

3.  USBケーブルのもう一方の端をビデオキャプチャワークステーションの使用可能なUSBポートに接続

します（仕様通りのパフォーマンスを得るにはUSB 3.0ポートを使用してください）。 

4. オプションで、別のSDIケーブル（別売）を使用してSDIモニターをSDI OUTポートに接続します。

モニターは、ビデオグラバーがワークステーションに接続されている場合にのみ機能することに

注意してください。 
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サードパーティのキャプチャアプリケーションを使用して、SDI2USB3.0からビデオをキャプチャ

することもできます。デバイスを選択するには、サードパーティのキャプチャアプリケーション

に付属するドキュメントを参照してください。 

 
 

Epiphan Capture Toolを使ってキャプチャする 

必要に応じて、起動方法についてEpiphan Capture Tool をご一読ください。 

 

1. Epiphan Capture Toolを起動する; ビデオソースがすぐに検出されます（No Signalというメッセ

ージが表示された場合は、ケーブルを取り外してから再接続して、すべてが正しく接続されてい

ることを確認します） 

 

2. ビデオグラバーからオーディオをキャプチャする場合は、ツールバーの[オーディオを有効にする

（Enable Audio）]ボタンをクリックする。オーディオが有効になっていることを示すためにアイコン

 

ビデオソースにスプリッターケーブルを使う場合、高品質のSDIスプリッターを使用して、他のデ

バイスとビデオグラバーの間で信号を分割します。SDI出力ポートは、ビデオキャプチャ、記録、

ストリーミング中に、ビデオをリモートモニターに同時に表示するための実用的な方法です。 
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埋め込みオーディオのキャプチャに問題がある場合、ビデオグラバーがUSB3.0ポートに接続され

ていることを確認してください。キャプチャする必要のあるデータの量が多いため、埋め込みオ

ーディオキャプチャは、USB3.0経由で接続されている場合にのみサポートされます。 

の表示が変わります。 （ソースにオーディオがない場合、または別のオーディオ入力方法を使用する

場合は、Capture » Audio Input Deviceを選択してオーディオソースを選択します。） 

 

 
 

3. 赤い録画ボタンを使うと録画が開始する。Save ダイアログが開き、ファイル名とファイルを保存す

るフォルダを指定します。 

 

 
4. キャプチャが完了したら、一時停止または停止ボタンで録画を停止する 

 

5. オペレーティングシステムのファイルブラウザで保存したキャプチャファイルを確認する 

 

 

What’s next? 

これで基本的な録音が完了します。その他の機能については以下をご参照ください。 

⚫ デバイス設定 

⚫ DirectShow video 調整 

⚫ Epiphan Capture Tool 
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取り上げる全トピックのリストは、目次をご参照ください。 
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LEDインジケーター の詳細 

インジケーターLEDの色と動作は、USB3.0とUSB2.0のどちらで接続しているかによって異なります。最高

のパフォーマンスを得るには、常にUSB3.0ポートと付属のUSB3.0ケーブルを使用してください。 USB 2.0

経由で接続すると、フレームキャプチャレートが低下することにご注意ください。 

コントローラーがUSB3.0かUSB2.0かわからない場合は、SDI2USB 3.0をキャプチャコンピュータに接続し、

インジケーターLEDを確認します（これをテストするには、ビデオグラバーにビデオソースが接続されてい

ないことを前提としています）。 

 

  

USB 3.0接続では青点滅します  USB 2.0接続では緑点滅します 

 

 

 

LED color USB 3.0接続 USB 2.0接続 

 

 

赤点灯 

ビデオグラバーの電源はオンになっていますが、機能してい

ません。ドライバがインストールされていないか、ロードに

失敗しました。Epiphan Capture Toolとドライバーをインス

トールした場合はUSBケーブルの抜き差しをお試しくださ

い。 

 

赤点滅 

ビデオグラバーのセキュリティ検証に失敗しました。製品の

シリアル番号とシステムの詳細をEpiphan社へ報告する必要が

あります。弊社までお知らせください。 

黄点灯 画像/ビデオキャプチャ、またはデータ転送中 

 

青点滅 

ファームウェアのロード

が成功し、デバイスは待

機状態 

 

- 
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緑点滅 

 

ビデオモードの検出中 

ファームウェアのロード

が成功し、デバイスは待

機状態 

 

緑点灯 

 

- 

ビデオモードの検出中 
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トラブルシュート 

SDI2USB 3.0で問題が発生している場合は、次のヒントから問題の修正をお試しください。 

 

Capture device not found 

 Epiphan Capture Toolがビデオグラバーを検出しない場合、キャプチャアプリケーションにCapture device 

not foundというメッセージが表示されます。  

 

次のトラブルシューティングのヒントをお試しください。 

⚫ ビデオグラバーがキャプチャワークステーションのUSBポートに接続されていることを確認します。

接続すると、デバイスのLEDが点灯します。 

⚫ USBポートからビデオグラバーを取り外してから再接続します。これにより、オペレーティングシステ

ムは、ビデオグラバーのドライバがまだロードされていない場合に、それらをロードできます。 

⚫ インジケーターLEDの色を確認し、LEDインジケーターの詳細に記載されているリストと比較します。 

⚫ Windowsでは、Windowsのデバイスマネージャーをチェックして、デバイスのリストにビデオグラ

バーが表示されていることを確認します。 

⚫ 上記を試しても問題が解決しない場合は、すべてのアプリケーションを閉じ、キャプチャワークス

テーションを再起動してください。 
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No signal detected 

Epiphan Capture Toolがビデオグラバーを検出したが、接続されたビデオソースが表示されない場合、キャ

プチャアプリケーションにNo signal detectedというメッセージが表示されます。 

 

 
 

次のトラブルシューティングのヒントをお試しください。 

⚫ アプリケーションで使用されているビデオグラバーが正しいことを確認します。ウィンドウ枠に記載

されているシリアル番号（上記の例では300292）と、デバイスの背面にあるシリアル番号のステッカ

ーを比較します。一致しない場合は、Capture » Select device... (Windows)項目を使用して、別のビ

デオグラバーを選択します。. 

⚫ ビデオソースがオンになっていて、ビデオグラバーに接続されているビデオケーブルにデータを出

力していることを確認します。（これは、ビデオソースのハードウェアまたはソフトウェアの設定

である可能性があります） 

⚫ ビデオグラバーからビデオソースを切断して再接続します。 

⚫ インジケーターLEDの色を確認し、LEDインジケーターの詳細に記載されているリストと比較します。 

 

設定変更を適用する「適用」ボタンが表示されない 

Windowsでは、Epiphan Capture Toolに設定変更を適用するためのボタンが表示されない場合、アプリケー

ションは管理者権限なしで開かれています。アプリケーションを閉じてから、管理者権限で再度開きます。 
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Windowsワークステーションの電源を入れても接続されているビデ

オグラバーが検出されない 

高 速 ス タ ー ト ア ッ プ を 無 効 に し て お 試 し く だ さ い 。 コ ン ト ロ ー ル パ ネ ル か ら 無 効 に で き ま す 。       

コントロールパネル > 電源オプション  > 電源ボタンの動作の選択  > 現在利用可能ではない設定を変更

しますをクリックし、高速スタートアップを有効にする（推奨）のチェックを外し、無効にする 

 

Windowsキャプチャワークステーションの問題が続く場合... 

電源設定の変更をお試しください。From コントロールパネル > 電源オプション > プラン設定の変更 

電源オプションが高パフォーマンスに設定されていることを確認してください。ワークステーションがラップ

トップの場合は、ACアダプターが接続されていることを確認してください。 

またプラン設定の変更で次の設定変更もお試しください。  

⚫ USB設定: USBのセレクティブサスペンド設定を無効に変更します。 

⚫ PCI Express: リンク状態の電源管理をオフにします。 

 

デバイスマネージャーを開き、ユニバーサルシリアルバスコントローラーにリストされているすべてのUSB 

3.0ハブに、プロパティ > 電源の管理で電源の節約のために、コンピュータでこのデバイスの電源をオフで

きるようにする設定が無効になっていることを確認します。 
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デバイス設定 
 

 

Epiphanを使用すると、画像調整を微調整し、DirectShow互換アプリケーションでビデオグラバーがどのように

機能するかを制御できます。 

設定画面にアクセスするには、次のいずれかを実行します。 

1. Epiphan Capture ToolからCapture » Configure Device... を選択する、または 

2. Windowsコントロールパネルを開く 

a. Epiphan Frame Grabbersアプレットをクリックする。設定画面が開きます。 

b. 設定したいグラバーを選択する 

c. Edit Configurationをクリックする。編集画面が開きます。  
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DirectShow video調整 

Epiphan Capture Toolの、Capture » Configure Device » Direct Show ペ ー ジ で は DirectShow互換アプリ

ケーションとど の よ う に や り 取 り を す る か 設 定 で き ま す 。 解 像 度 か ら 画 像 を 反 転 す る か ど う か ま

で 様 々 な オ プ シ ョ ン を 利 用 で き ま す 。 各 オ プ シ ョ ン の 説 明 に つ い て は 、 以 下 の 表 を ご 参 照 く だ

さ い 。  

コントロールパネルにあるEpiphanアプレットからも、設定したいビデオグラバーを選択し、Configure 

Device または Default Configurationをクリックすることで、この画面へアクセスできます。 

ここで行った調整はデバイスドライバに保存され、再度変更するまで使用されます。一度適用すると、設定し

た値を使用するために、Epiphan Capture Toolを開いたままにする必要はありません。サードパーティの

DirectShow互換アプリケーションに設定が反映されていないように見える設定が含まれている可能性がありま

す。変更を確認できない場合は、サードパーティアプリケーションの詳細設定を確認してください。 

 

 

 

 

 

 



SDI2USB 3.0 User Guide DirectShow video adjustments 

21 

 

 

Item Description 

 

 

 

Fix resolution 

このチェックボックスを使用して、ビデオグラバーがDirectShow互換ア

プリケーションに受け渡す解像度を指定します。チェックボックスをオン

にすると、ドロップダウンボックスに、目的の解像度を選択するための解

像度のリストが表示されます。 

ソース映像よりも小さいまたは大きい解像度を選択すると、Epiphanドラ

イバが画像を拡大縮小します（Scale image to match stream resolution

のチェックをオフにしない限り、選択した解像度に一致するように画像が

トリミングされます）。 

 

Default image 

ビデオグラバーからキャプチャされた信号がない場合に表示する画像を

選択します。非圧縮のBMPイメージを、ビデオキャプチャワークステー

ションに保存する必要があります。 

 

 

 

 

 

 

 

Scale image to match 

stream resolution 

固定解像度を使用していて、画像を拡大縮小しないことを選択した場

合、DirectShow互換ユーティリティでキャプチャすると、キャプチャさ

れた画像は指定された解像度にトリミングされて表示されます。通常、

トリミングは映像の左上隅で行われますが、最初にテストして、同じ結

果が表示されることを確認してください。 

通常、DirectShowで固定解像度を使用することを選択する場合は、

Epiphanドライバで画像を拡大縮小する必要があります。スライダーを使

用して、必要なスケーリングのタイプを決定します。スケーリングパフ

ォーマンスは、キャプチャコンピュータの品質とCPUサイクルに影響を

受けます。低品質（スライダーの左側）は高速でCPUサイクルが少なく

て済みますが、高品質（スライダーの右側）は低速でCPU時間が長くな

ります。さまざまな値を試して、ご利用時に適した値を見つけてくださ

い。 

 

Flip image vertically 

DirectShowを送信するときにキャプチャした画像を垂直方向に反転す

るには、このチェックボックスを使用します。 
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Limit frame rate to 

DirectShowに送信するデータのフレームレートを制限（または修

正）します。 

たとえば、WebExのようなDirectShow互換のアプリケーションを

使 用 し て い て 、 比 較 的 静 的 な も の を 共 有 し て い る 場 合

（PowerPointプレゼンテーション）、フレームレートを5fpsに制

限できます。見ている人には十分なフレームレートであり、データ

パイプが同じ画像でいっぱいになるのを防ぎます。 
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映像の見え方の調整 

Adjustmentsペ ー ジ で は デ ー タ の わ ず か な 変 化 と キ ャ プ チ ャ 元 の カ ラ ー モ ー ド を 管 理 す る よ う に

デ バ イ ス を 構 成 で き ま す 。  

この画面にアクセスするには、Capture » Configure Device » Adjustments または コントロールパネル

のEpiphanアプレットを使用して、構成するビデオグラバーを選択し、Configure Device または Default 

Configuration をクリックします。 

メイン調整画面は以下のとおりです。 

 

 

Item Description 

 

 

 

Horizontal shift 

キャプチャされた画像の位置をオフセットするように水平シフトを設

定します。たとえば、キャプチャした画像が少し右に（水平に）シフ

トしている場合、水平シフトの設定を少し調整するだけで修正できま

す。Horizontal Shiftに入力した値を大きくすると、画像が右に、小さ

くすると、画像が左にシフトします。 
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Vertical shift 

キャプチャされた画像の位置をオフセットするように垂直シフトを設

定します。たとえば、わずかに下向き（垂直方向）にシフトされたキ

ャプチャ画像は、垂直方向のシフト設定をわずかに調整することで修

正できます。 

Vertical Shiftに入力された値を増やすと画像が上にシフトし、減らす

と画像が下にシフトします。 

 

YCrCb capture 

通常、SDI2USB 3.0は入力タイプを自動検出しますが、入力タイプが検

出されない問題が発生した場合は、このチェックボックスを選択して、

YCrCbエンコーディングでアナログコンポーネント映像をキャプチャで

きます。 

 

Swap interlaced fields 

ソースによってはキャプチャする場合、ビデオグラバーはインターレ

ースラインを配置する順序を正しく決定できません。このチェックボ

ックスを使用して、問題を解決します。 
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Advanced調整 

Advancedペ ー ジ で デ バ イ ス の 自 動 調 整 を 設 定 で き ま す 。  

 

この画面にアクセスするにはCapture » Configure Device » Advanced を選択するか、コントロールパネル

のEpiphanアプレットを使用して、設定するビデオグラバーを選択し、Configure Device または Default 

Configurationをクリックします。 

Advanced調整ダイアログは次のようになります。 

 

 
 

Item Description 

 

 

Auto-adjustment interval 

ビデオグラバーが自動調整の間に使用する間隔を秒単位で指定します。通

常、この値を変更する必要はありませんが、キャプチャ中にソースを頻繁

に変更する場合は、間隔を短くすることをお勧めします。 
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On-board compression 

このオプションは、USB2.0ポートに接続されている場合にのみ表示

されます。 USB 2.0ポートに接続したときに着信信号のオンボード圧

縮を有効にするには、このオプションを選択します。  

 

 

 

 

SDI2USB 3.0は、入力タイプを自動検出します。ただし、入力タイプが検出されない場合は、メ

インのAdjustmentsタブからYCrCbエンコーディングを使用してアナログコンポーネントビデオ

をキャプチャするように手動で選択できます。ビデオグラバーがインターレースラインを配置す

る順序を正しく決定できない場合は、メインのAdjustmentsタブからインターレースフィールド

を交換することもできます。 
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Epiphan Capture Tool 
 

 

The same Epiphan Capture Tool is used by all Epiphan video grabber models that use Epiphan-supplied 

drivers (e.g. DVI2USB 3.0, SDI2USB 3.0, VGA2USB, DVI2PCIe Duo and more) as well as Epiphan's 

portable USB-based KVM, KVM2USB. As a result, some of the functionality in the software isn't 

applicable to your SDI2USB 3.0 video grabber. This guide outlines which functions are relevant and 

explains how to use each one. Epiphan Capture Toolは、Windowsで利用できる無料のソフトウェアアプリ

ケーションです。このツールを使用して、ソースから映像または画像をキャプチャ、保存できます。また、

このツールを使用して、サードパーティのDirectShow互換アプリケーションで使用するようにビデオグラバ

ーを構成することもできます。 

同じEpiphan Capture Toolは、Epiphanが提供するドライバ（DVI2USB 3.0 、SDI2USB 3.0 、DVI2PCIe Duo 

など）を使用するすべてのEpiphanビデオグラバーモデルで使用されます。その結果、ソフトウェアの一部の

機能は、SDI2USB3.0ビデオグラバーには適用されません。このガイドでは、関連する機能の概要と、各機能

の使用方法について説明します。 

https://www.epiphan.com/products/dvi2usb-3-0/
https://www.epiphan.com/products/sdi2usb-3-0/
https://www.epiphan.com/products/vga2usb/
https://www.epiphan.com/products/dvi2pcie-duo/
https://www.epiphan.com/products/kvm2usb/
https://www.epiphan.com/products/dvi2usb-3-0/
https://www.epiphan.com/products/sdi2usb-3-0/
https://www.epiphan.com/products/dvi2pcie-duo/
https://www.epiphan.com/products/dvi2pcie-duo/
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Epiphan Capture Tool 

アプリケーションを起動するにはWindowsスタートメニューからStart » Epiphan Capture Toolを選択する

か、インストールされているデスクトップアイコンをダブルクリックします。 

アプリケーションが起動すると、PCに接続されているSDI2USB3.0ビデオグラバーを探します。 

 

ビデオグラバーが接続されて動作している場合、キャプチャアプリケーションはそれを検出し、キャプ

チャされている画像がアプリケーションディスプレイに表示されます  

 

アプリケーションが起動すると、次のメッセージが表示される場合があります。 

⚫ Capture device not found：アプリケーションがビデオグラバーとの接続を試みるとき 

⚫ Detecting Video Mode： ア プ リ ケ ー シ ョ ン が デ バ イ ス に 接 続 し 、 デ バ イ ス の ビ デ

オ モ ー ド を 決 定 す る と き  

⚫ Tuning Capture Parameters：アプリケーションがキャプチャ設定と画像調整を同期、調整する

とき 

⚫ No Signal Detected：アプリケーションがアクティブなビデオソースに接続されていないビデオ

グラバーに接続している場合 

ビデオソースが接続されているときにビデオグラバーデバイスが画像をキャプチャしない場合は、次のトラ

ブルシューティングのヒントに従ってください：Troubleshoot 
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Epiphan capture toolには以下のメニュー項目があります。 

 

 
 

以下のトピックのメニューの詳細をお読みください： File menu, Edit menu (Windows), View menu, 

Capture menu, Tools menuHelp menu, Toolbar, Status bar. 

Menus：メニュー（File、Edit、View、Capture、Tools、Help） 

Toolbar：ツールバー 

Currently selected video grabber： 現在選択されているビデオグラバー 

Current capture info：現在接続されているキャプチャ情報 

Captured source： キャプチャソース 

Status bar：現在の状況 
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Menus 

ここではEpiphan Capture ToolにあるMenuについて説明します。 

 

File menu 

Fileメニューの内 訳 で す 。  

 

 

Fileメ ニ ュ ー に は 次 の オ プ シ ョ ン が あ り ま す : 

 

Menu item Short cut Description 

 

Save 

 

Ctrl+S 

現在の画像のスナップショットをビデオキャプチャワークステーショ

ン上のファイルに保存します。参照 スナップショットを保存するに

は 

 

Save As... 

 

Ctrl+Shift+S 

新しい名前または形式を使用して、現在の画像のスナップショット

をファイルに保存します。参照 スナップショットを保存するには 

 

Print Setup... 

 

Ctrl+Shift+P 

プリンター設定ダイアログを開き、プリンターを選択したり、プリン

ターオプションを設定したりできます。 
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Print Ctrl+P 現在の画像のスナップショットを印刷します。参照 To print a 

snapshot. 

Exit 
 

アプリケーションを閉じ、Epiphanキャプチャツールのこのインスタ

ンスを介して実行されたすべてのキャプチャと録画を終了します。 

Edit menu (Windows) 

Editメニューの内 訳 で す 。  

 

 

Editメ ニ ュ ー に は 次 の オ プ シ ョ ン が あ り ま す : 

 

Menu item Short cut Description 

 

Copy 

 

Ctrl+C 

現在の画像のスナップショットをクリップボードにコピーします。

参照 To copy a snapshot. 

 

View menu 

Viewメニューの内 訳 で す 。  

 

 

Viewメ ニ ュ ー に は 次 の オ プ シ ョ ン が あ り ま す : 

 

Menu item Short cut Description 
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Toolbar 

 
ツールバーアイコンのサイズを変更するか、ツールバーを表示/非表示にしま

す。 （ツールバーが非表示になっている場合は、サイズを選択して復元しま

す。） 

 

 

Status Bar 

 
アプリケーションウィンドウの下部にあるステータスバーを表示または非表

示にします。 

 

 

Full Screen 

 

Ctrl+F 

フルスクリーンモードを有効にします。ESC（エスケープキー）を押してウ

ィンドウモードに戻ります。 

 

 

 

 

Image Only 

 

 

 

 

(ESC to exit) 

Epiphan Capture Toolを、ウィンドウの境界線、ツールバー、ステータス

バー、メニューバーが表示されないモードにします（スクロールバーは引

き続き表示される場合があります）。 

画像のみのモードは、Epiphan Capture ToolをカスタムシステムUIに統合

するのに役立ちます。既存のショートカットキーは引き続き使用できま

す。 

ESC（エスケープキー）を押して、通常の動作モードに戻ります。 

 

Capture menu 

Captureメニューの内 訳 で す 。  

 

The Captureメニューではキャプチャ/録画を開始、停止、一時停止できます。また、ビデオキャプチャワー

クステーションに複数のEpiphanビデオグラバーが接続されている場合に、アプリケーションのこのインス

タンスが動作するSDI2USB3.0デバイスを選択することもできます。 
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Captureメ ニ ュ ー に は 次 の オ プ シ ョ ン が あ り ま す : 

 

Menu item Short cut Description 
 

Start Recording 

(Stop Recording) 

 

Ctrl+R 

キャプチャしたストリームをビデオまたは一連のキャプチャした画像とし

て録画を開始/停止します。参照 映像保存 と一連の画像として保存 

Pause Capture 

(Resume 

Capture) 

 

Ctrl+U 

 

キャプチャと録画を一時停止または一時停止解除します。（最後のフレー

ムは画面に表示されたままになります）参照 ビデオキャプチャの一時停止 

 

 

 

 

 

 

 

 

Select Device... 

 

 

 

 

 

 

 

 

Ctrl+N 

ビデオキャプチャワークステーションに複数のEpiphan Proシリーズビデオ

グラバーが接続されている場合に使用します。 

Epiphan Capture Toolのこのインスタンスで使用するデバイスを選択し、

OKをクリックします。 
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Connect 

Network 

Device... 

  

 

 

 

 

この製品ドキュメントの範囲外で、EpiphanのレガシーVGA2Ethernet

デバイスとともに使用されます。 

Disconnect 

Network 

Device 

Recent 

Network 

Devices 

Enable Audio 

Capture 

(Disable 

Audio 

Capture) 

 

 

Ctrl+A 

 

有効にすると、デバイスまたは構成済みの外部オーディオソースによって

キャプチャされたオーディオが録画に含まれます。参照 音声設定. 

Audio 

Input Device 

 
サブメニューを開き、オーディオキャプチャに使用する入力デバイスを選

択できます。参照  音声設定 
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Play 

Captured Audi 

o 

 
有効にすると、キャプチャされたオーディオは、ビデオキャプチャワー

クステーションで再生されます（たとえば、ワークステーションのスピ

ーカーまたは接続されたヘッドフォンを介して）。モニタリングとして

使用して、録画しているオーディオを確認したり、キャプチャしている

オーディオをローカルの視聴者と共有したりします。 

Play Captured Audio設定を機能させるには、Enable Audio Captureを

有効にする必要があります。 

Configure 

Device... 

 

Ctrl+Shift+C 

ダイアログを開き、ビデオグラバーの特定のキャプチャ調整を構成できま

す。参照 デバイス設定 

 

Tools menu 

Epiphan Capture ToolのToolsメニューでは、カスタムEDIDをアップロードし、アプリケーションオプションを

設定できます。 

 

 
 

Toolsメニューには次のオプションがあります。 

 

Menu item Short cut Description 

Upload EDID to Device... 
 

この機能は、SDI2USB3.0には適用されません。 

Read EDID from Device... 
 

この機能は、SDI2USB3.0には適用されません。 
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Measure VGA Mode... 

 
Epiphanテクニカルサポートから要求された場合、この

コマンドを使用して、問題の診断に役立つ情報を表示で

き ま す 。 こ の 情 報 を 電 子 メ ー ル に コ ピ ー す る か 、

Epiphanテクニカルサポートとチャットしてください。 

 

Upgrade EDIDs for all Devices 

 
Epiphanは、ビデオグラバー用に更新された汎用EDIDを

随時リリースしています。このツールを使用して、更新

を確認し、適用します 

 

 

Options 

 
ビデオのキャプチャ、ビデオの録画などに関連するいく

つかのオプションを構成できます。参照Application 

options  

 

アプリケーションオプション 

Epiphan Capture Toolには、Tools » Options メ ニ ュ ー からアクセスできる多数の使用可能な構成オプション

があります。 

 

次のカテゴリのオプションを使用できます：Recording、On-Screen Text、KVM、Display、

Capture、Audio、Startup 

 

 
 

Options ダイアログには以下のタブが用意されています。 

 

Menu item Description 

 

 

 

Display 

キャプチャツールでキャプチャされた画像を表示する方法と、ステータ

スバーに表示される情報を制御できます。表示形式については  表示オプ

ションの設定 を、オプションのステータスバーインジケータの説

明と例については、Status bar をご参照ください。  
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Capture 

トリミングを構成できます（ビデオフレームの特定の部分のみをキャプチ

ャするため）。参照 キャプチャイメージをクロップする 

このタブから、video mode detection（ビデオモードの検出）の間隔を変

更することもできます。数値を小さくすると、グラバーが別のビデオモー

ドをチェックする頻度が高くなりますが、グラバーの動作が激しくなり、

フレームレートが低下する可能性もあります。 

最後に、このタブから、キャプチャのフレームレートを制限（limit the 

frame rate）することもできます。これは、ストリーミング（または録

画）していて、帯域幅（またはディスク容量）が少なく、データが多すぎ

て圧倒されたくない場合に必要になることがありま 

 

 

 

Audio 

録画のオーディオ形式、使用するオーディオソース、キャプチャワークス

テーションのオーディオ出力デバイス（つまり、キャプチャされたオーデ

ィオのモニタリングに役立つローカルスピーカーやヘッドフォン）でキャ

プチャされたオーディオを再生するかどうかを構成できます。 ）。参照  

音声設定 

 

 

Startup 

Epiphan Capture Toolをフルスクリーンモードで起動するかどう

かを選択できます。 

このタブの他のオプションは、レガシーEpiphan製品

（VGA2Ethernetなどのネットワーク接続ビデオグラバー）に使用

されます。 

 

Recording 

ビデオまたは画像として保存するようにキャプチャアプリケーション

の録画機能を構成できます。参照 映像保尊、録画設定のオプション、

一連の画像として保存 
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Menu item Description 

 

On-Screen Text 

Epiphan Capture Toolを使用すると、キャプチャされたフレームに透かし

を追加できます。このタブでは、その透かしを構成できます。参照 オーバ

ーレイの追加 

KVM この機能は、SDI2USB3.0では使用されません。 

 

Help menu 

Epiphan Capture ToolのHelpメニューを使用すると、ソフトウェアの更新を確認したり、製品を登録し

たり、現在のソフトウェアのインストールに関する情報を確認したりできます。 

 

 

Help » Check for Updatesメニューを使用して、Epiphan Capture Toolとドライバの更新を確認します。 

ソフトウェアの更新バージョンがある場合もありますが、新しい機能が追加されたり、使用しているビデオグ

ラバーのモデルが更新されたりすることはありません。このような場合、ソフトウェアの更新チェックでは更

新が推奨されませんが、ドライバとソフトウェアのアップグレードで記載している方法を使用してソフトウ

ェアを更新することができます。 
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Toolbar 

Epiphan Capture Tool ツールバーには、キャプチャの開始、停止、一時停止、スナップショットの保存など、

頻繁に使用される機能のクイックアクセスボタンがあります。 

Toolbar: 

 

 

View » Toolbar » (size) Iconsからツールバーのアイコンサイズを変更できます。 

 

View » Toolbar » Hide Toolbarからツールバーを非表示にすることもできます。非表示のときにツールバー

を再度表示するには、ツールバーアイコンのサイズのいずれかを選択します。 

ツールバーのアイテム: 

 

Icon 

(Windows) 

 

Description 

 

 

現在のキャプチャフレームのスナップショットを保存します。最初にキャプチャを一

時停止することをおすすめします。参照：  スナップショットのコピー、保存、印刷  

 

 

 

現在のキャプチャフレームを印刷します。最初にキャプチャを一時停止することをおすす

めします。参照：  スナップショットのコピー、保存、印刷  

 

 

 

現在のキャプチャフレームをフリップボードにコピーします。最初にキャプチャを一時停

止することをおすすめします。参照：  スナップショットのコピー、保存、印刷  

 

 

 

キャプチャされているフレームの録画を開始 (と停止)します。（画像、ビデオ形式） 

参照： 映像保存 と一連の画像として保存 

 

 

 

キャプチャと録画の一時停止に使用します。（録画時、録画ファイルは閉じます） 
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音声キャプチャの有効/無効にする。参照 音声設定  
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スナップショットのコピー、保存、印刷 

Epiphan Capture Toolを使用して、ストリームからスナップショットをコピー、保存、印刷ができます。 

 

スナップショットを保存するには 

次のいずれかの方法でキャプチャしているストレームを.bmp、.jpg、.png形式で保存します。オプションと

して画像を保存する前に ビデオキャプチャの一時停止 ができます。 

⚫ File » Save を選択する 

⚫ Ctrl+S を押す 

⚫ ツールバーの保存アイコンを使う 

 

 

スナップショットを初めて保存するときに、Save As [名前を付けて保存]ダイアログが開き、ファイルの場

所とファイルの種類を尋ねられます。 File » Save As... または Ctrl + Shift +Sを使用しない限り、後続の画

像はこのファイルを自動的に上書きします。 

 

スナップショットを印刷するには 

次のいずれかの方法でストリームからスナップショットを直接印刷できます。オプションとして画像を保存

する前に ビデオキャプチャの一時停止 ができます。 

⚫ File » Print を選択する 

⚫ Ctrl+P を押す 

⚫ ツールバーの印刷アイコンを使う 
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メニューオプションのFile » Print Set up... またはキーボードショートカットのCtrl + Shift +Pを使用して、

プリンターを選択し、プリンター設定を構成します。 

オプションで、印刷用に色を反転させることを選択できます（黒は白、黄色は青、赤はシアンなどとして表

示されます）。印刷用に色を反転するには： 

1. Tools » Options を選択する。オプションダイアログが開きます。 

2. Displayタブを選択する 

3. Invert colors for printing のチェックボックスにチェックを入れる 
 

 
 

4. OKをクリックする 

 

スナップショットをコピーするには 

次のいずれかの方法でクリップボードにストリームのスナップショットを簡単にコピーできます。オプショ

ンとして画像を保存する前に ビデオキャプチャの一時停止 ができます。 

⚫ Edit » Copy を選択する 

⚫ Ctrl+C を押す 

⚫ ツールバーのコピーアイコンを使う 
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ワークステーションで別のアプリケーションを開き、クリップボードの貼り付け方法（Edit » Paste や Ctrl 

+V など）を使用してコピーした画像を貼り付けます。 

映像保存 

Epiphan Capture Toolは、SDI2USB3.0からキャプチャされた画像を映像として保存できます。 

 

音声をキャプチャすることを選択でき (参照 音声設定) 、映像の代わりに個々の画像ファイルを保存するこ

とも選択できます。参照 一連の画像として保存. 

キャプチャした映像ソースの映像を保存するには： 

 

Step 1: コーデックを設定する 

エンコーディングコーデックを選択してください。コーデックは圧縮されていないビデオフレームを

SDI2USB 3.0から取得し、それらをデジタルビデオファイルに結合/圧縮して、プレーヤーで表示したり、共

有したり、YouTubeなどの動画共有サイトにアップロードしたりできるソフトウェアです。 

初期設定では、オペレーティングシステムにはいくつかのコーデックがインストールされており、Epiphan 

Capture Toolには追加のコーデックは付属していません。 x264などのサードパーティコーデックをインスト

ールすることを選択できます。使用に合わせた最適なコーデックを選択することはこのユーザーガイドの範囲

を超えていますが、インターネット上でこのトピックに関する多くのリソースをご覧いただけるかと思います。 

コーデックを設定するには: 

1. 映像ソースをビデオグラバーに接続する 

2. キャプチャワークステーションのUSBポートへビデオグラバーを接続する。（最高のパフォー

マンス、またはエンベデッド音声をキャプチャするにはUSB3.0を利用してください。） 

3. インストールしたEpiphan Capture Toolを起動する。参照 Epiphan Capture Tool 

4. Tools » Options メニューを選択する。ダイアログが開きます。 

a. Recording タブを選択する 
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b. Record as ドロップダウンでVideoが選択されていることを確認する 

c.  Select Codec... ボタンを押し、Video Compressionダイアログを開く。システムにインスト

ールされているコーデックから選択し、OKをクリックする。Video Compressionダイアログ

が閉じます。 

d. 必要に応じて、 AVI file size limit （AVIファイルのサイズ制限）を変更する。この制限に達

すると、録画は自動的に停止します。 

e. このページからファイル名や録画時間などの 録画設定のオプションも設定できます。  

f. Recording 設定を保存するため、適用をクリックする 
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Step 2: 録画 

Epiphan Capture Toolで適切に設定できれば、映像を録画するだけです。 

画像/フレームはビデオグラバーによってキャプチャされると、ビデオファイルに保存されます。ステータ

スバーには、ビデオファイルの名前と場所、録画の経過時間、保存されたフレーム（または画像）の数が表

示されます。 

録画するには: 

1. Epiphan Capture Toolはすでに映像ソースをキャプチャし、表示されているはずです。（もしNo 

Signalが表示されている場合は、ケーブルの抜き差しを試し、全ての接続が正しくされているか、確認

してください。）  

 

2. オプションとして、音声キャプチャを設定し、有効にする。参照 音声設定 

 

3. Capture » Start Recording,を選択するか、赤い録画ボタン、またはキーボードショートカットCtrl 
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+R を使って録画を開始する 

 

4. ファイル名と保存先フォルダを指定する。（録画ファイル名を事前設定するには 録画設定のオプショ

ン をご参照ください。) 

5. 取得が完了すれば、pauseまたはstopボタンを押して録画を停止する。 (キーボードショートカット

のCtrl +Uを使用して一時停止する、メニューのCapture » PauseまたはCapture » St op Recording

を使用して録画を停止することもできます。） 

 

6. オペレーティングシステムのファイルブラウザ（Windowsエクスプローラ）を使用して、保存されて

いるキャプチャファイルを探す。Epiphan Capture Toolの下部にあるステータスバーが表示されてい

る場合、最後に保存されたファイルのファイル名とパスが表示されます。 

 

ビデオファイルがAVIファイルサイズの制限に達すると、録画設定に基づいて次のいずれかが発生します。 

⚫ 録画が停止する 

⚫ 録画が継続され、新しいビデオファイルが作成される 

⚫ 録画が継続され、元のファイルが上書きされる 

 

録画オプションを設定するには、録画設定のオプションをご参照ください。 

 

埋め込まれた音声のキャプチャに問題がある場合は、ビデオグラバーがUSB3.0ポートに接続され

ていることを確認してください。キャプチャする必要のあるデータの量が多いため、埋め込み音

声キャプチャは、USB3.0経由で接続されている場合にのみサポートされます。 
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キャプチャイメージをクロップする 

多くの場合、SDI2USB3.0によってキャプチャされた映像全体を保存する必要があります。 

ただ場合によっては、一部の情報（機密情報や個人情報など）を削除したり、シーンの黒いバーや不要な領域

を切り取ったりする必要があります。このような場合に、Epiphan Capture Toolには、保存する前にキャプチ

ャされたソースをクロッピングする機能があります。 

たとえば、クロッピングを使うと、キャプチャを下の左側の画像を右側の画像のように、一部を切り取った画

像に表示を変更できます。ステータスバーには、クロッピングされた座標が表示されます。 

 

 

キャプチャクロッピングを設定するには、まず映像保存をします。

クロッピングの位置を指定するため: 

1. Tools » Options ダイアログからCapture tab.タブを選択する 

2. Enable hardware croppingのチェックボックスにチェックを入れる 
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3. I Width（幅） と  Height（高さ） にキャプチャしたいクロップ範囲のサイズをピクセル単位で

指定する 

4. Left（左） と Top（上） に キ ャ プ チ ャ を 始 め る 左 上 隅 の ピ ク セ ル を 指 定 す る 。 こ れ ら の

値 を 変 更 す る こ と で 、 ク ロ ッ プ 範 囲 で 表 示 さ れ る 画 像 が 変 化 す る こ と を 確 認 で き ま す 。  

5. うまく調整ができ、変更が確認できればApply（適用）、OKをクリックする。 
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表示オプションの設定 

Epiphan Capture Toolsでは、キャプチャしたフレームの表示方法をいくつか設定できます。たとえば、

画面を大きくしたり小さくしたりするときに画像を拡大縮小するかどうか、または画面上で画像を回転さ

せるかどうかを選択できます。 

 

表示オプション 

これらのオプション設定を行うには、Epiphan Capture ToolのTools » OptionsからDisplayタブを選択します。 

 

 

利用可能な表示設定項目を以下で紹介します。このオプションのステータスバー表示についてはこのタブと

は別の場所に設定する場所があるので、注意してください。ステータスバーをご参照ください。 
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Menu item Description 

 

 

 

 

Display format 

キャプチャに使用する色空間を変更できます。色空間は、キャプチャし

た映像の見た目と、データをキャプチャできる最大フレームレートに影

響します。色空間の変更は、画面に表示される内容と、Epiphan 

Capture Toolを介して保存される内容に影響します。 

Epiphan Capture Toolは、さまざまなRGB、グレースケールカラーフォ

ーマットをサポートしていますが、SDI2USB 3.0は、このカラースペー

スをサポートするサードパーティツールを使用している場合、YUV 4：

2：0カラースペースでキャプチャすることもできます。 

  

 

 

 

 

 

 

1080p 60 fpsでビデオキャプチャする場合、YUV 4：2：0をサポート

するサードパーティのキャプチャアプリケーションを使用する必要が

あります。 

 

 

 

Image scaling 

このオプションを使用して、キャプチャした画像をキャプチャ画面のサイ

ズに自動的に縮小するかどうかを選択します。選択を解除すると、画像が

アプリケーションウィンドウよりも大きい場合にスクロールバーが表示さ

れます。 

この設定は表示にのみ適用され、保存された画像や映像のフレームサイズ

は影響を受けません。 

 

 

 

Image rotation 

必要に応じて、Epiphan Capture toolでキャプチャソースを回転できま

す。例えば、カメラやソースを右や左に90度、または適切に表示する

ために180度回転させる必要がある場合に有効です。ドロップダウンリ

ストから目的の回転を選択し、Apply、OKをクリックして、表示を確

認します。 

この設定は、表示と保存した画像/映像のどちらにも影響します。 
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Resize window on resolution 

change 

ソースの解像度が変わったときに、アプリケーション画面のサイズを変

更する場合は、このチェックボックスにチェックをします。 

 

Invert colors for printing 

印刷の際、色を反転させられます。黒は白、黄は青、赤はシアンなどで表

示されます。 

 

 

 

 

Flip image vertically 

チェックボックスにチェックを入れると、画像が垂直方向に回転しま

す。キャプチャされたフレームの上端に沿ってミラーが配置されている

かのような見え方です。 

水平方向に反転するには、このオプション設定に180度画像回転を行いま

す。 

子の設定は表示と保存した画像/映像のどちらにも影響します。 

 

追加機能 

ここでは、キャプチャエクスペリエンスを最大限に活用するのに役立つ追加機能について紹介します。 

 

 

ステータスバー 

Epiphan Capture Toolには、SDI2USB3.0または現在選択されているビデオグラバーに関する情報を表示

するステータスバーがあります。設定や現在の利用状況に応じてステータスバーに追加されるさまざま

な表示については、以下をご参照ください。 

接続されているビデオグラバーがない 

ソフトウェアが接続されているビデオグラバーを検出しない場合、ステータスバーにはcapture device not 

found（キャプチャデバイスが見つからない）を示します。 

 

選択されているビデオグラバーへの入力信号がない 

現在選択されているビデオグラバーへの信号がない場合、ステータスバーにはno signal で示します。 
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準備できているが、録画していない 

それ以外の場合、ステータスバーには様々な情報が表示されます。録画を実行中でない場合、ステータスバ

ーは録画を開始する準備ができていることを示し、ステータスバーの右側にソース信号のモードを表示しま

す。 

 

映像保存 

初期設定では、映像保存を実行すると次のようになります（RECORDINGタグ、ファイルの保存場所、時間、

フレーム数がステータスに追加されます）。 

 

映像保存完了 

映像保存が完了すると、ステータスバーが更新され、最終的なファイルの場所と時間が表示されます。これは、

アプリケーションが閉じられるか、映像保存が再開されるまで、ステータスバーに表示されます。 

 

画像保存 

ソースを一連の画像として保存する場合、ステータスバーにRECORDINGタグと現在のファイルの名前が表

示されます。 

 

画像保存完了 

画像保存が完了すると、ステータスバーに保存された画像フレームの数が表示されます。 
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オプション情報 

Tools » Options » Display メニューの設定項目に従って、ステータスバーにその他にも情報が表示できます。

以下のように多くの場合、個別に示されていますが、これらのオプション項目を全て同時に表示することもで

きます。キャプチャ画面がすべてのデータを表示するのに十分な幅であることを確認する必要がある場合があ

ります。 

⚫ 現在のキャプチャフレームレート 

 

⚫ 左上隅（例では：0,0）、右下隅、結果のフレームサイズを示すクロップ範囲 

 

 
⚫ 音声エンコーディング情報 

⚫ アプリケーションの開始以降にビデオグラバーがキャプチャしたフレームまたは画像の数 

 

 

ビデオキャプチャの一時停止 

ツールバーの一時停止ボタンを使用するか、キャプチャメニューから一時停止にアクセスするか、キーボー

ドショートカットのCtrl +Uを使用してキャプチャを一時停止できます。キャプチャを一時停止すると、次

のことが起こります。 

⚫ 最後にキャプチャされたフレームはEpiphan Capture Toolで開いたままになります (新しいフレー

ムは取得されません)。この画像は保存、コピー、印刷できます。参照  スナップショットのコピー、

保存、印刷 

⚫ も映像保存していた場合: 

⚫ 現在の映像保存（該当する場合）は閉じられます。 

⚫ （Tools » Optionsダイアログで）Automatically restart capture （キャプチャを自動的
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に再開する）がオフになっている場合、映像保存は停止され、ファイルが完成します。 

⚫ Automatically restart capture（キャプチャを自動的に再開する）がオンになっている場合は、

もう一度一時停止を押すか、Capture » Resume Captureを選択すると、設定に応じて、一時

停止が解除され、既存のファイルが上書きされるか、新しいファイルが開始されます。参照 録

画設定のオプション 

⚫ 画像保存していた場合: 

⚫ それ以上の画像（該当する場合）は保存されません。 

⚫ もう一度一時停止を押すと、すぐに画像キャプチャが再開されます。 

 

キャプチャの一時停止は、ライブストリーミングも行っている場合に特に便利です。これにより、機密情報

をキャプチャせずに、別のものを準備したり、パスワードを入力したりできます。 

 

一連の画像として保存 

There are two ways you can record using the Epiphan capture toolとSDI2USB 3.0を使って保存を行う

には、個々の画像キャプチャか、映像キャプチャかの２つの方法があります。参照 映像保存 

 

一連の画像として映像ソースをキャプチャするには： 

Step 1: キャプチャモード、ファイル形式、キャプチャ頻度を設定する 

初期設定では、By default, the Epiphan Capture Tool capturesは映像形式で保存されるため、保存を開始

する前にモードの変更が重要です。 

画像キャプチャモードとファイル形式を設定するには: 

1. 映像ソースをビデオグラバーに接続する 

2. キャプチャワークステーションのUSBポートにビデオグラバーを接続する（ベストパフォーマ

ンスのためUSB3.0をご利用ください） 

3. Epiphan Capture Toolを起動する 

4. Tools » Options を選択する。ダイアログが開きます。 

5. Recording タブを選択する 

 

一連の画像としてソースを保存する場合、音声はキャプチャできません 
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6. Record as ドロップダウンでImagesが選択されていることを確認する 

7. Format ロップダウンでBMP、PNG、JPEG (JPG)からいずれかを選択する 

8. Save options 項目で 

 

 

a. ファイルの保存先フォルダを指定する。指定しない場合はEpiphan Capture Toolと同じフォル

ダに保存されます。 

b. 必要に応じて、ファイルごとのカスタムPrefixを指定する 

c. Suffixドロップダウンで、サフィックスに10進数（d）または16進数（X）のどちらの文字を使用

するか、ファイル名の頭に付くゼロの数を設定する。（たとえば、％04dは4桁の10進数のサフ

ィックスを意味します。最初の数個は3つの先行ゼロ（cap_0001.bmp）） 

d. St art値を、ファイル名で使用する最初の数値に設定する 
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e. Exampleで、ファイル名の設定結果を確認する 

f. 新しい画像を古い画像に上書きする場合は、Overwite existing files （既存のファイルを上書きす

る）のチェックボックスにチェックを入れる 

g. 画像がまだ保存されているかどうかに関係なく続行する場合は、Ignore write failures （書き込

みの失敗を無視する）のチェックボックスにチェックを入れる。 （たとえば、✓を入れると、

ディスクスペースが不足した場合、またはファイルの書き込みを妨げる権限の問題がある場合

に警告が表示されません） 

9. 画像を保存する頻度を決定する。すべてのフレームを保存すると、1秒あたり最大30枚の画像が

保存されるため、ハードドライブの容量がすぐに大きくなる可能性があります。 

 

10. Save all frames （すべてのフレームを保存）を選択して、各フレームを画像として保存する 

11. Skipを選択し、Xフレームごとに画像を保存する値を設定する。（たとえば、Skipを10に設定する

と、10フレームごとに画像が保存されます） 

12. Waitを選択し、画像を保存する時間間隔を設定する。数秒または数分ごとにフレームを収集保存

します。（ミリ秒、秒、分、時間から選択します） 

13. 特定の数の画像のみを保存するか、指定された時間が経過したら保存を停止するかを決定する 

 

 
 

14. 録画ボタン/コントロールを使用して画像の保存を停止するには、Automatically turn recording 

off （自動的に録画をオフにする）はチェックしないでください。それ以外の場合は、チェック

ボックスにチェックを入れ、フレームまたは時間で制限を指定します。 

15. Recording 設定を保存するため、適用、OKをクリックする 

 

Step 2: 映像保存 

Epiphan Capture Toolが適切に設定されていれば、一連の画像を保存するだけです。 
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画像/フレームはビデオグラバーによってキャプチャされるため、個別の画像ファイルとして保存されます。

キャプチャ中、ステータスバーには最後に保存された画像の名前と場所が表示されます。保存した画像の総

数は、保存が停止したときに表示されます。 

画像を保存するには: 

1. Epiphan Capture Toolは、すでに映像ソースをキャプチャしてプレビューしているはずです。No 

Signalというメッセージが表示された場合は、ケーブルの抜き差しを試し、全ての接続が正しくされて

いるか確認してください。 

 

2. Capture » Start Recordingを選択し、赤い録画ボタンまたはキーボードショートカットのCtrl +Rを

使用して保存を開始する。Saveダイアログが開きます。 

 

3. キャプチャが完了したら、一時停止または録画ボタンで、保存を停止する。キーボードショートカ

ットのCtrl +Uを使用して一時停止したり、メニュー項目のCapture » PauseまたはCapture » Stop 

Recordingを使用して保存を制御したりすることもできます。 
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キャプチャする必要のあるデータの量が多いため、埋め込みオーディオキャプチャは、

USB3.0経由で接続されている場合にのみサポートされます。 

 

4. オペレーティングシステムのファイルブラウザ（Windowsエクスプローラ）を使用して、保存されて

いる画像ファイルを見つける 

 

 

音声設定 

SDI2USB 3.0は、暗号化されていないSDIソースから直接音声をキャプチャできます。 Epiphan Capture 

Toolは、キャプチャワークステーションに接続されている他のオーディオデバイス（たとえば、USBやオー

ディオ入力ジャックを介して接続されている組み込みのラップトップマイク、外部マイク）から音声をキャ

プチャすることもできます。 

初期設定では、Epiphan Capture Toolは音声をキャプチャしませんが、設定は簡単です。 

 

Step 1: 音声ソースを選択する 

キャプチャする音声ソースを選択することから始めます。これは、Tools » Options、またはCaptureメニューか

ら直接、のいずれかから実行できます。 

音声ソースを選択するには： 

 

1. オペレーティングシステムを使用して外部音声ソースを設定する（通常、内蔵マイクの設定は必要あり
ません） 

2. または、SDI ソースをビデオグラバーに接続する 

3. Connect the video grabber to a USB 3.0 port on your capture workstation (you can use USB 

2.0 if you're planning to use an external audio source instead of embedded audio). ビデオグラバ

ーをキャプチャワークステーションのUSB3.0ポートに接続する。（埋め込みオーディオの代わりに

外部音声ソースを使用する場合は、USB 2.0を使用できます）。 
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4. Epiphan Capture Toolを起動する. 

5. Tools » Options を選択すると、Optionsダイアログが表示されます。 

a. Audioタブを選択する 

 

 

a. 埋め込まれたSDI音声をキャプチャする場合は、Frame Grabberを選択する 

b. 外部音声ソースを使用している場合は、Specific Windows audio input deviceをクリック

して、リストからオーディオデバイスを選択する 

c. 必要に応じて、Audio formatドロップダウンで、保存（またはストリーミング）するオーディ

オビットレート、ステレオ/モノラル、ビット深度を指定する。 （この値が入力音声と異なる

場合ビットレート、SDI2USB 3.0は指定されたビットレートにリサンプリングします。） 

d. 必要に応じて、Play captured audio （キャプチャされた音声を再生する）チェックボックス

にチェックを入れ、キャプチャワークステーションの音声出力デバイス（キャプチャワーク

ステーションに接続されたスピーカーやヘッドフォンなど）で音声を再生する 

e. Apply、OKをクリックする 

6. または、Capture » Audio Input Deviceを選択し、リストから音声ソースを選択する 
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Step 2: 音声キャプチャを有効にする 

ツールバーを見ると、音声キャプチャが有効になっているかどうかがわかります。スピーカーアイコンが表

示されている場合（そこから音波が出ていない場合）、音声は有効になっていません。以下の例を参照して

ください。 

 

音声が有効 音声が無効 

 

 

 

 

 

 

 

音声キャプチャを有効にするには: 

1. Epiphan Capture Toolを起動する 

2. ツールバーのCapture Audio （音声キャプチャ）ボタン（スピーカーアイコン）をクリックする。音

声キャプチャが有効になっている場合、アイコンは音波でアニメーション化されます。 

音声キャプチャを無効にするには: 

1.   Capture Audio （音声キャプチャ）ボタンをクリックする。アイコンのアニメーションが停止します。 

 

Step 3: キャプチャする 

ツールバーの録画ボタンを使って、音声/映像ストリームをキャプチャします。 
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録画設定のオプション 

映像保存で記載しているように、キャプチャしたフレームを映像として保存する場合、いくつかのオプショ

ンの設定ができます。 

自動ファイル名を設定する（自動再開） 

録画と一時停止の組み合わせを使用し、Epiphan Capture Toolで前のファイルを上書きするか、初めて録画を

開始する時に指定されるベースのファイル名に追加されるファイル名のサフィックスを作成するように設定す

ることにより、保存するたびにファイル名を入力する必要がなくなります。 

まず、ビデオグラバーをキャプチャワークステーションに接続し、ソースをビデオグラバーに接続します。キ

ャプチャツールを起動し、必要に応じて映像保存の手順に従って映像を保存するように設定します。 

録画する度に同じファイルを上書きするには: 

1. Tools » Options » Recording タブで、Automatically restart recordingチェックボックスにチェックを

入れる. 

 

 

2. Overwrite the same file (old content will be lost) のボタンをクリックする 

3. OKをクリックする 

4. 映像保存を開始し、ファイルの保存場所と名前を指定する 

5. 録画の合間にツールバーの pause ボタン (キーボードショートカット Ctrl +U または Capture » 

Pause )をクリックして、録画を停止し、もう一度クリックして再開し、前のファイル名を自動的に上書

きする 

 

一連の映像ファイルを保存するには (それぞれ異なるサフィックスを付けて): 

1. Tools » Options » Recordingタブで、Automatically restart recording （録画を自動的に再開する）チ

ェックボックスにチェックを入れる 
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2. Create a new file every time recording is restarted ボタンをクリックする 

3. Suffixドロップダウンを使用して、サフィックスに10進数（d）または16進数（X）のどちらの文

字を使用するか、ファイル名に付く先行ゼロの数を指定する。（たとえば、％04dは4桁の10進

数のサフィックスを意味します。最初のいくつかには、3つの先行ゼロ（cap_0001.bmp）が付

きます） 

4. オプションとして、シーケンスの開始の値（starting with）を選択する 

5. オプションとして、同じ名前のファイルが既にある場合に自動的に上書きする場合は、Overwrite 

existing files （既存のファイルを上書きする）チェックボックスにチェックを入れる。 

6. OKをクリックする 

7. 録画を開始し、ファイルの場所とルート名を指定する 

8. 録画中、合間にツールバーのpauseボタン（キーボードショートカットCtrl +UまたはCapture » 

Pause）をクリックし、もう一度pauseボタンをクリックして再開し、シーケンス内の名前で新し

いファイルを自動的に作成します。 

録画周期の設定 

必要に応じて、指定した時間が経過した後、または指定した数のフレームが保存された後に録画を停止する

ようにEpiphan Capture Toolで設定できます。たとえば、超音波装置からキャプチャするときに常時、1分の

映像保存が必要である場合など。 

まず、ビデオグラバーをキャプチャワークステーションに接続し、ソースをビデオグラバーに接続します。

キャプチャツールを起動し、必要に応じて、映像保存の手順に従って録画するように設定します。 

録画する度に同じファイルに上書きするには: 

1. Tools » Options » Recording タブでAutomatically turn recording offチェックボックスにチェックを
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入れる 

 

2. どちらかのボタンを選択して、いくつかのフレームが保存された（number of frames have 

been saved）後、または指定された時間が経過（elapsed）した後に停止するように指定する 

3. 制限値を入力する：フレーム数または時間（ミリ秒、秒、分、時間） 

4. OKをクリックする 

5. 通常とおり録画を開始する。停止する基準が満たされると、録画は自動的に停止します。 

オーバーレイの追加 

Using the Epiphan Capture Toolで、キャプチャした映像/画像に、タイムスタンプ、その他の固定のテキス

ト形式を画面上で透かしを追加できます。 

 

 

タイムスタンプを追加する 

事前に作成された形式から1つ選択し、フォント、サイズ、場所、色を選択することにより、キャプチャし

た映像にタイムスタンプを追加できます。 

まず、ビデオグラバーをキャプチャワークステーションに接続し、ソースをビデオグラバーに接続します。

キャプチャツールを起動し、必要に応じて映像保存の手順に従って録画設定を行います。 

タイムスタンプのオーバーレイを設定するには: 

1. Tools » Options ダイアログから、On-Screen Textタブを選択する 

2. Timestamp チェックボックスにチェックを入れる 
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3. Formatドロップダウンからタイムスタンプの形式を選ぶ. 

4. 必要に応じて、color（ 色 ） と outline （アウトラインの色）を変更する。初 期 設 定 ： ： color :白 、

outline :グ レ ー  

5. Position 内のグリッド位置をクリックして、タイムスタンプを表示する位置を指定する 

6. Font の横にある (...)  をクリックして、フォントの種類とサイズを変更する。フォント設定ダ

イアログが開きます。 

7. 設定が完了したら、Applyをクリックして設定を適用する。OK をクリックするとダイアログが閉じ

ます。 

タイムスタンプと固定のテキストーバーレイの両方を含めることができることに注意してください。 

 

固定テキストオーバーレイを追加する 

テキストを追加し、フォント、サイズ、場所、色を選択することで、キャプチャした映像に固定テキストを

追加できます。 

まずビデオグラバーをキャプチャワークステーションに接続し、ソースをビデオグラバーに接続します。キ

ャプチャツールを起動し、必要に応じて、映像保存の手順に従って録画設定を行います。 
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Tip: カスタムフォントジェネレーターを使用して、会社のロゴ、その他のグラフィックの単調バージ

ョンを含むフォントを生成し、画像に「テキスト」としてオーバーレイすることができます。こうす

ると、グラフィカルなオーバーレイがあるように見えます。 

固定のテキストオーバーレイを設定するには: 

1. Tools » OptionsダイアログからOn-Screen Textタブを選択する 

2. Static text チェックボックスにチェックを入れる 
 

 
 

3. Text に 文 字 を 入 力 す る  

4. 必要に応じて、colorとoutlineの色を初期設定の白とグレーの値から変更する 

5. 位置グリッド内の場所をクリックして、固定のテキストオーバーレイの場所を指定する 

6. フォント説明の横にある（...）をクリックして、フォントの種類とサイズを変更する 

7. 設定が完了したら、Applyをクリックして変更を確認し、OKをクリックしてダイアログを閉じる 

キャプチャした映像または画像に、テキストオーバーレイとタイムスタンプマークの両方を付けることがで

きます。 
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コマンドラインオプション 

コマンドラインオプションを使用して、Epiphan Capture Toolの起動方法を制御できます。必要な数のコマ

ンドラインオプションを任意の順序で追加します。各コマンドラインオプションは2つのダッシュで始まり、

スペースで他のオプションと区切られます。 

次のコマンドラインオプションがサポートされています。 

 

Option Description 

 

--borderless 

画像のみのモードでキャプチャアプリケーションを起動します。 Escキ

ーを押して、画像のみのモードを終了します。 

 

--sn <serial number> 

使用するビデオグラバーを指定します（複数のビデオキャプチャワーク

ステーションが接続されている場合）。 < serial number >は、目的の

ビデオグラバーのシリアル番号です。 

--hs <value> 水平シフト値を設定します。* 

--vs <value> 垂直シフト値を設定します。* 

--phase <value> サンプリング位相値を設定します。* 範囲は 0～31 

--pll PLL調整を設定します。* 

--offset <value> オフセット（明るさ）を設定します。* 範囲は 0～63  

--gain <value> ゲイン（コントラスト）を設定します。* 範囲は 0～63  

 

--topmost 

キャプチャアプリケーションウィンドウを画面の一番上のウィンドウと

して保持します。 

--fullscreen Epiphan Capture Tool を全画面モードで起動します。 

"* "に関しては デバイス設定 をご参照ください。 

例 

1つ以上のコマンドラインオプションを含むデスクトップショートカットを作成できます。この例では、

Epiphan Capture Toolの実行可能なファイル名はv2ugui2.exeであり、 

C:\ Program Files\ Epiphan\ Frame Grabber Software 

にインストールされています。 
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1. Windows エクスプローラを開き、次のパスに移動する：C:\ Program Files\ Epiphan\ Frame 

Grabber Software 

2. v2ugui2.exe を 右 ク リ ッ ク し て 、 Create Short cutを選択する。Windowsはショートカットファイル

を作成します。Windowsの設定によっては、「Shortcuttov2ugui2.exe.lnk」という名前になる場合が

あります。Windowsでファイル拡張子が表示されない場合、“.lnk”が表示されない場合があります。 

3. 必要に応じて、ファイル名を変更し、別の場所にコピーする。ファイル拡張子は変更しないでくださ

い。 

4. ショートカットファイルを右クリックしPropertiesを選択する 

5. Target を 編 集 し 、 終 了 引 用 符 の 後 に コ マ ン ド ラ イ ン オ プ シ ョ ン を 追 加 す る  
 

 
 

 

6. OK を選択して、変更をショートカットに保存する 

7. ショートカットをダブルクリックして、指定したコマンドラインオプションでビデオキャプチャア

プリケーションを開始する 

 

または--topmost、-borderlessを追加するには、水平シフトを-67に設定し、垂直シフトを10に設定しま

す。 

"C:\ Program Files\ Epiphan\ Frame Grabber Software\ v2ugui2.exe" –topmost --borderless --hs -67 

-- vs 10 

 

例えば、-topmostコマンドラインオプションを追加するには、ターゲット行を次のように変更します。 

"C:\ Program Files\ Epiphan\ Frame Grabber Software\ v2ugui2.exe" –topmost 
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付録 
 

 

⚫ ドライバとソフトウェアのアップグレード 

⚫ 制限と既知の問題 

⚫ ソフトウェアのライセンス 
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SDI2USB3.0を使用する各キャプチャワークステーションのドライバとEpiphanソフトウェアを必

ず更新してください。デバイスを接続するたびに、デバイスはキャプチャコンピュータから毎回

ファームウェアをリロードします。 

 

ドライバとソフトウェアのアップグレード 

ドライバと最新バージョンのEpiphan Capture Toolは、単一のパッケージにまとめられており、製品の

Epiphan VideoサポートWebサイト（または弊社HP：ダウンロードサイト）からダウンロードできます。 

SDI2USB 3.0を登録すると、ドライバの更新が利用可能になったときに通知を受け取るように選択できます。 

通常、古いバージョンをアンインストールせずに、新しいEpiphan Capture Toolとドライバをダウンロード

してインストールできます。 クイックスタート のドライバーインストール手順に従って、デバイスドライ

バを更新し、最新のEpiphan Capture Toolをインストールします。 

https://www.argocorp.com/grabber/eizou/Epiphan/Epiphan_software.html
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制限と既知の問題 

ここでは、現在リリースの機能またはユーザビリティに影響を与える既知の問題または制限が含まれ、

それらの回避策が提供されます。 

⚫ ビデオワークステーションの複数のアプリケーションで同時に映像信号を開くと、信号のパフォーマ

ンスに影響します。ライブストリーミングおよび録画中に最高のパフォーマンスを得るには、映像信

号にアクセスする不要なアプリケーションをすべて閉じることをお勧めします。たとえば、ライブス

トリーミングや録画にEpiphan Capture Toolを使用していない場合は、ビデオグラバーの構成が完了

したらツールを閉じます。 
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Software license 

ATTENTION: THE SOFTWARE AND DOCUMENTATION PROVIDED UNDER THIS AGREEMENT ARE BEING LICEN SED 

TO YOU BY EPIPHAN SYSTEM S INC. ("LICEN SOR") AND ARE NOT BEING SOLD. THIS AGREEMENT CONTAINS 

LIMITATIONS ON REPRESEN TATION S, WARRANTIES, CONDITION S, REMEDIES, AND LIABILITIES THAT ARE 

APPLICABLE TO THE SOFTWARE AND DOCUMENTATION. 

Epiphan Systems Inc.  
 

Software License 
 

IMPORTANT: BEFORE DOWNLOADING, IN STALLIN G, OR USIN G THE SOFTWARE AND DOCUMENTATION, PLEASE 

CAREFULLY READ THIS AGREEMENT WHICH CONTAINS THE TERMS AND CONDITIONS UNDER WHICH YOU ARE 

ACQUIRING A LICEN SE TO USE THE SOFTWARE AND DOCUMENTATION. IF YOU DO NOT ACCEPT THE TERMS AND 

CONDITIONS OF THIS AGREEMENT PLEASE DO NOT DOWNLOAD, IN STALL, OR USE THE SOFTWARE AND 

DOCUMENTATION AND PROMPTLY RETURN OR DESTROY THE SOFTWARE AND DOCUMENTATION. IF YOU 

DOWNLOAD, IN STALL, OR USE THE SOFTWARE AND/ OR DOCUMENTATION, YOU WILL HAVE ACCEPTED AND 

AGREED TO THESE TERMS AND CONDITION S. THE SOFTWARE, HARDWARE AND DOCUMENTATION ARE ALSO 

PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER 

INTELLECTUAL PROPERTY LAWS. IF YOU ARE AN AGENT OR EMPLOYEE OF AN ENTITY, YOU REPRESEN T AND 

WARRANT THAT (I) THE INDIVIDUAL ACCEPTING THIS AGREEMENT IS DULY AUTHORIZED TO ACCEPT THIS 

AGREEMENT ON SUCH ENTITY'S BEHALF AND TO BIND SUCH ENTITY, AND (II) SUCH ENTITY HAS FULL POWER, 

CORPORATE OR OTHERWISE, TO ENTER INTO THIS AGREEMENT AND PERFORM ITS OBLIGATIONS UNDER THIS 

AGREEMENT. 

1. Definitions: In this Agreement: 

 

"Agreement" means this Epiphan System s Inc. Software License; 

 

"API" means an application programming interface; 

 

"Documentation" means the technical publications delivered to You with the Software relating to the 

installation and operation of the Software and/ or Hardware, such as reference, user, installation and technical 

guides and release notes; 

"Epiphan" means Epiphan System s Inc; 
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"Epiphan Hardware Product" means an Epiphan hardware product (including enclosure and mechanical parts, 

circuitry and electrical and electronic components contained therein) purchased by You, which is intended to be 

used in conjunction with the licensed Software and Documentation; 

"License Key" means a series of computer-generated characters used for the purpose of controlling the operation 

of Epiphan Hardware Products and/ or related Software; 

"Soft ware" means the Licensor binary and/ or bytecode software and/ or firmware programs that are (i) 

specified in Your Order or that are included with or in the Epiphan Hardware Products specified in Your Order, (ii) 

are made available to You for download after acceptance of this Agreement, (iii) are packaged with this Agreement, 

(iv) pre- installed on Epiphan Hardware Products, (v) embed this Agreement in their installer(s) and which are 

installed after acceptance of this Agreement, or (vi) embed this Agreement in their product documentation. 

Software also includes the related Documentation; 
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"You" or "Your" means the individual acquiring the Software license or any entity on whose behalf such individual is 

acting. In the case of an entity, "You" includes any entity that by majority voting interest controls, is controlled by, 

or is under common control with You; and 

"Your Order" means (i) the web forms provided by Epiphan or its applicable reseller or distributor for ordering 

Epiphan Hardware Products and related Software licenses, or (ii) written documents executed by Epiphan, or 

one of its resellers or distributors, and You in respect to Your purchases of Epiphan Hardware Products and/ or 

related 

Software licenses. 

 

2. Grant of Soft ware License: Subject to the terms and conditions of this Agreement, including payment of any 

applicable fees specified in Your Order, Licensor grants You a non-exclusive, non-transferable, non-

sublicensable, 

internal license to use the number of copies of the Software specified in Your Order and to use the Software 

functions specified in Your Order solely for operation on the Epiphan Hardware Products for which such Software 

has been designed as specified in the Documentation for such Software. If the number of copies of Software is not 

specified in Your Order, then the number of copies shall be a reasonable number of copies. You acknowledge and 

agree that the ability to use certain Software functions is controlled by a Licensing Key and that You will not be 

able to use such 

functions unless You have paid the applicable fees charged by Epiphan for the right to use such functions and to 

receive a Licensing Key to enable such functions. For functions that are controlled by a Licensing String You shall 

only use that Licensing String with the copy of the Software for which it was issued and You shall not use that 

copy of the Licensing String with any other copies of the Software that You may have or make. All copies of the 

Software made by You shall include all trademarks, copyright notices, restricted rights legends, proprietary 

markings and the like exactly as they appear on the copy of the Software originally provided to You. No other rights 

in the Software or 

Documentation are granted to You. 

 

3. Open Source Soft ware: Binary, bytecode and source code versions of certain open source software packages 

may be embedded in or distributed with the Software ("Open Source Software"). If a separate license agreement for 

an 

item of open source software is: delivered to You with the Software; included in the download package for the 

Software; referenced in any material (including the Documentation) that is included in the download or distribution 

package for the Software; or listed at www.epiphan.com/opensource, then such open source software shall be Open 

http://www.epiphan.com/opensource
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Source Software and such separate license agreement shall govern Your use of that item or version of such open 

source software. The Open Source Software may include free software (i.e. software licensed under the GNU 

Lesser General Public License or other free software licenses) for which the applicable free software license may 

also require 

that the source code for such free software be made available to those receiving only executable versions of such 

free software. If the source code for any free software distributed with the Software is not provided with the 

Software, 

then upon request, within a three (3) year period from the original receipt of the binary or bytecode version of 

such Open Source Software from Licensor, for a fee that shall not exceed Licensor's costs associated with the 

shipping of 

the source code for such free software, Licensor will provide a copy of the source code for such free software to You. 

 

4. Restrictions: The terms set forth in this Section 4 are additional conditions to the licenses granted in Section 2. 

Your right to use the Software is conditioned upon Your timely payment of the full amount of fees due for: (i) the 

Epiphan Hardware Product(s) on which You want to use the Software; (ii) all support agreements You have 

entered into with Licensor or any of its distributors and/ or resellers; (iii) licensed Software and Documentation. 

You shall not reverse engineer, disassemble, reverse translate, decompile or in any other manner decode any 

Epiphan Hardware Product or Software except to the extent the Software is distributed with any Open Source 

Software that prohibits the imposition of such a restriction or to the extent the foregoing restriction is 

expressly 

prohibited by applicable law notwithstanding a contractual obligation to the contrary. You acknowledge and agree 

that no rights in respect to the source code of the Software are granted to You. You acknowledge and agree that the 
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rights in respect to use of the Software and Documentation are granted only for use in conjunction with Epiphan 

Hardware Products. You shall not distribute, lease, rent, grant a security interest in, assign, or otherwise 

transfer the 

Software except as expressly provided in this Agreement. You shall not modify or create any derivatives works of the 

Software or merge all or any part of the Software with another program. Notwithstanding the foregoing, You may 

call public APIs made available by Epiphan in the Software from applications developed by or on Your behalf 

provided 

that such applications do not embed any of the Software other than the minimum linkage materials required to call 

separately running instances of the Software. You shall not use the Software or make the Software available to 

any third parties as part of any service bureau, time sharing service, application service provider offering, software-

as-a- service offering or any other managed service offering. You shall not disclose any performance, benchmarking, 

or feature-related information about the Software. You further agree not to disclose, transfer or otherwise 

provide to any third party any portion of the Software, except as expressly permitted herein. 

Som e Epiphan Hardware Products and Software embed third-party APIs that integrate with third-party party 

services (“Third-Party Services”) to allow users of such Epiphan Hardware Products and Software to interact with 

such Third- Party Services for various capabilities offered by such Third-Party Services, such as, and without 

limitation, 

authentication, uploading and downloading of video content and other features made available by such Third-Party 

Services. If You access or use any Third-Party Service and/ or related APIs using an Epiphan Hardware Product 

and/ or the Software then You shall comply with all of the terms and conditions for such Third-Party Service and/ 

or related APIs. 

5. Disclaimer of Warranties: EXCEPT FOR ANY WARRANTIES THAT MAY BE PROVIDED IN ANY COMMERCIAL 

AGREEMENT EXECUTED BETWEEN YOU AND LICEN SOR (OR BETWEEN YOU AND ONE OF LICEN SOR’S RESELLERS OR 

DISTRIBUTORS), THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE AND/ OR DOCUMENTATION ARE PROVIDED 

“AS IS”, WITHOUT ANY REPRESEN TATION S, CONDITION S, AND/ OR WARRANTIES OF ANY KIND. WITHOUT 

LIMITATION, LICEN SOR AND ITS AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, 

SUBCON TRACTORS, RESELLERS AND DISTRIBUTORS DISCLAIM ANY AND ALL IMPLIED REPRESEN TATION S, 

CONDITIONS AND/ OR WARRANTIES OF MERCHANTABILITY, MERCHANTABLE QUALITY, NON-INFRINGEMENT, 

DURABILITY, COMPATIBILITY, TITLE, SATISFACTORY QUALITY AND/ OR FITNESS FOR A PARTICULAR PURPOSE 

WHETHER ARISIN G BY STATUTE, COURSE OF DEALING, USAGE OF TRADE OR OTHERWISE. EXCEPT AS OTHERWISE 

EXPRESSLY PROVIDED IN ANY COMMERCIAL AGREEMENT EXECUTED BETWEEN YOU AND 

LICEN SOR (OR BETWEEN YOU AND ONE OF LICEN SOR’S RESELLERS OR DISTRIBUTORS), THE ENTIRE RISK OF THE 
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USE OF THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE AND/ OR DOCUMENTATION SHALL BE BORNE BY YOU. 

EXCEPT AS OTHERWISE EXPRESSLY PROVIDED IN ANY COMMERCIAL AGREEMENT EXECUTED BETWEEN YOU AND 

LICEN SOR (OR BETWEEN YOU AND ONE OF LICEN SOR’S RESELLERS OR DISTRIBUTORS), NEITHER LICEN SOR NOR 

ANY OF ITS AFFILIATES NOR ANY OF ITS OR THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS AND/ 

OR DISTRIBUTORS MAKE ANY REPRESEN TATIONS OR PROVIDE ANY CONDITIONS AND/ OR WARRANTIES ABOUT 

THE SUITABILITY OF THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE, SERVICES AND/ OR DOCUMENTATION. 

NEITHER LICEN SOR NOR ANY OF ITS AFFILIATES NOR ANY ITS OR THEIR LICEN SORS, SUPPLIERS, SUBCON 

TRACTORS, RESELLERS AND/ OR DISTRIBUTORS MAKE ANY REPRESEN TATIONS OR PROVIDE ANY CONDITIONS AND/ 

OR WARRANTIES WHATSOEVER ABOUT ANY INFORMATION AND/ OR DATA THAT MAY BE PROCESSED BY OR 

MADE AVAILABLE USIN G ANY EPIPHAN HARDWARE PRODUCT AND/ OR SOFTWARE OR ABOUT ANY THIRD-PARTY 

SERVICE THAT MAY BE ACCESSIBLE USIN G ANY EPIPHAN HARDWARE PRODUCT 

AND/ OR SOFTWARE. 

 

6. LIMITATION OF LIABILITY: NEITHER LICEN SOR NOR ANY OF ITS AFFILIATES NOR ANY OF ITS OR THEIR LICEN 

SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS AND/ OR DISTRIBUTORS SHALL HAVE ANY LIABILITY TO YOU OR 

ANY OTHER PERSON OR ENTITY FOR ANY DAMAGES ARISIN G FROM THIS AGREEMENT, RELATING TO 
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THE HARDWARE, SOFTWARE OR DOCUMENTATION, OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICEN 

SOR (INCLUDING ITS AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS 

AND/ OR DISTRIBUTORS) IN RELATION TO THE EPIPHAN HARDWARE PRODUCTS, SERVICES, SOFTWARE AND/ OR 

DOCUMENTATION FOR ANY INDIRECT, RELIANCE, INCIDENTAL, SPECIAL, PUNITIVE, 

EXEMPLARY OR CON SEQUEN TIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, 

LOSS OF OR DAMAGE TO DATA, BUSIN ESS INTERRUPTION, LOSS OF DATA, REPLACEMENT OR RECOVERY COSTS, 

OR OTHER COMMERCIAL OR ECONOMIC LOSS, WHETHER ARISIN G FROM CONTRACT, EQUITY, TORT 

(INCLUDING NEGLIGENCE OR STRICT LIABILITY) OR ANY OTHER THEORY OF LIABILITY, EVEN IF LICEN SOR 

(INCLUDING ITS AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS 

AND/ OR DISTRIBUTORS) HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE 

FORESEEABLE. THE LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR 

DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR TERM OR FUNDAMENTAL BREACH. SOM E 

JURISDICTION S DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CON SEQUEN TIAL OR 

INCIDENTAL DAMAGES, SO THESE LIMITATIONS MAY NOT APPLY TO YOU. IN NO EVENT SHALL THE TOTAL 

CUMULATIVE LIABILITY OF LICEN SOR (INCLUDING ITS AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, 

SUBCON TRACTORS, RESELLERS AND DISTRIBUTORS) TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY 

DAMAGES ARISIN G FROM THIS AGREEMENT, RELATING TO THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE, 

DOCUMENTATION AND/ OR RELATING TO ANY SERVICES PROVIDED TO YOU BY LICEN SOR (INCLUDING ITS 

AFFILIATES AND ITS AND THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS AND DISTRIBUTORS) IN 

RELATION TO THE EPIPHAN HARDWARE PRODUCTS, SOFTWARE AND/ OR DOCUMENTATION, EXCEED THE LICEN 

SE FEES PAID BY YOU FOR THE SOFTWARE. 

NOTWITHSTAN DING ANY OTHER PROVISION IN THIS AGREEMENT, NEITHER LICEN SOR NOR ANY OF ITS 

AFFILIATES OR ITS OR THEIR LICEN SORS, SUPPLIERS, SUBCON TRACTORS, RESELLERS AND/ OR DISTRIBUTORS 

SHALL HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY WHATSOEVER IN RESPECT TO ANY 

DIRECT, INDIRECT, RELIANCE, INCIDENTAL, SPECIAL, PUNITIVE, EXEMPLARY OR CON SEQUEN TIAL DAMAGES, 

INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOSS OF OR DAMAGE TO DATA, BUSIN ESS 

INTERRUPTION, LOSS OF DATA, REPLACEMENT OR RECOVERY COSTS, OR OTHER COMMERCIAL OR ECONOMIC 

LOSS, ARISIN G FROM OR RELATING TO ANY INFORMATION AND/ OR DATA THAT MAY BE PROCESSED BY OR 

MADE AVAILABLE USIN G ANY EPIPHAN HARDWARE PRODUCT AND/ OR SOFTWARE OR ARISIN G FROM OR 

RELATING TO ANY THIRD-PARTY SERVICE THAT MAY BE ACCESSIBLE USIN G ANY EPIPHAN HARDWARE 

PRODUCT AND/ OR SOFTWARE. 

THE DISCLAIM ER OF REPRESEN TATION S, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY 



SDI2USB 3.0 User Guide Software license 

78 

 

 

CON STITUTE AN ESSEN TIAL PART OF THIS AGREEMENT. YOU ACKNOWLEDGE THAT BUT FOR THE DISCLAIM ER OF 

REPRESEN TATION S, WARRANTIES AND CONDITIONS AND LIMITATION OF LIABILITY, NEITHER LICEN SOR NOR 

ANY OF ITS AFFILIATES OR ITS OR THEIR LICEN SORS, SUPPLIERS, RESELLERS OR DISTRIBUTORS WOULD GRANT 

THE RIGHTS GRANTED IN THIS AGREEMENT. 

7. Term and Termination: This Agreement shall continue for as long as You use the Software, however, it may be 

terminated sooner as provided in this Section 7. You may terminate this Agreement by destroying all copies of the 

Software and Documentation under Your control and providing certification of such destruction to Licensor or 

by 

returning the Software to Licensor. Licensor may terminate this Agreement immediately by providing You with 

written notice if: (a) You are in material breach of any provision of this Agreement, which breach, if capable of 

being cured, is not cured within thirty (30) days after Licensor gives You written notice thereof; or (b) You have 

committed a non- 

curable material breach of this Agreement. Upon termination You shall destroy all copies of the Software and 

Documentation. In addition to this Section, the Sections entitled Definitions, Disclaimer of Warranties, 

Limitation of 
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Liability, Title, Indemnities, High-Risk Activities, Intellectual Property, and General shall continue in force even 

after any termination of this Agreement. No termination of this Agreement will entitle You to a refund of any 

amounts paid by You to Licensor or any reseller or distributor or affect any obligations You may have to pay any 

outstanding 

amounts owing to Licensor or any reseller or distributor. Upon any termination of this Agreement, Your license to the 

Software and Documentation will terminate and You shall destroy all copies of the Software and 

Documentation under Your control and certify such destruction to Licensor. 

8. Support and Updates: This Agreement does not grant You the right to any updates or enhancements of the 

Software or the right to receive any technical support for the Software. Such updates and other technical 

support 

services, if available, may be purchased separately from Licensor or one of Licensor’s resellers or distributors. Use 

of any updates or enhancements to the Software provided pursuant to any technical support You may procure from 

Licensor or one of Licensor’s resellers or distributors shall be governed by the terms and conditions of this 

Agreement. Licensor reserves the right at any time not to release or to discontinue the release of any Software and 

to alter prices, features, specifications, capabilities, functions, licensing terms, release dates, general availability or 

other characteristics of the Software. 

9. Title: All right, title, and interest (including all intellectual property rights) in, to, and under the Software 

(including all copies thereof) shall remain with Licensor and its licensors. 

10. Indemnities: You shall indemnify, defend and hold Licensor, its affiliates, its and their licensors, suppliers, 

subcontractors, resellers and/ or distributors and all of the directors, officers, employees of all of the foregoing 

(collectively the “Indemnified Parties”) harmless from and against any damages, losses, liabilities, expenses, costs, 

claims, demands, actions, suits and/ or proceedings incurred by the Indemnified Parties as a result of (i) Your use 

of the Epiphan Hardware Products, Software and/ or Documentation, (ii) any use of the Epiphan Hardware 

Products, Software and/ or Documentation on Your behalf, (iii) the use of the Epiphan Hardware Products, 

Software and/ or Documentation by anyone to whom You give the Epiphan Hardware Products, Software and/ or 

Documentation, 

and/ or (iv) the use of the Epiphan Hardware Products, Software and/ or Documentation on behalf of anyone to 

whom You give the Epiphan Hardware Products, Software and/ or Documentation, including, without limitation, in all 

of the foregoing cases, any damages, losses, liabilities, expenses, costs, claims, demands, actions, suits and/ or 

proceedings arising from or relating to any information and/ or data that may be processed by or made 

available using any Epiphan Hardware Product and/ or Software or arising from or relating to any Third-Party 

Service that may be accessible using any Epiphan Hardware Product and/ or Software (collectively, each matter 
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falling within any of the foregoing, a “Claim”), including, without limitation, indemnifying, defending and holding 

the Indemnified Parties 

harmless from and against any settlements agreed by You in connection with any Claims and/ or any damages, 

costs or other amounts (including reasonable attorneys' fees) awarded to a third party against any of the 

Indemnified 

Parties by a court or tribunal of competent jurisdiction in respect to any Claim. If You do not timely defend 

against or resist a Claim after notice from Licensor, Licensor shall be entitled to investigate, defend, compromise, 

settle, or 

otherwise dispose of the Claim, and incur costs in connection therewith, at Your expense, in such manner as 

Licensor deems in its best interests until a reasonable time after You comply with its obligations under this 

Section 10. You shall not enter into a settlement of any Claim without the Licensor’s written consent unless such 

settlement is solely for monetary payment by You and contains an express, complete, unconditional release of all 

of the Indemnified 

Parties and which does not impose any obligations or restrictions on any of the Indemnified Parties. 

 

11. High-Risk Activities: The Software and Epiphan Hardware Products are not fault-tolerant and are not designed, 

manufactured or intended for use in or in conjunction with on-line control equipment in hazardous 

environments 

requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation systems, air traffic 



SDI2USB 3.0 User Guide Software license 

81 

 

 

 

control, or direct life support machines. Licensor, its licensors, suppliers, subcontractors, resellers and 

distributors specifically disclaim any express or implied representations, warranties and/ or conditions for such 

uses. 

12. U.S. Government  End-Users: The Software and Documentation are each a "commercial item" as that term 

is defined at FAR 2.101, consisting of "commercial computer software" and "commercial computer software 

documentation" as such terms are defined in FAR 12.212, and are provided to the U.S. Government only as 

commercial end items. Government end users acquire the rights set out in this Agreement for the Software, Epiphan 

Hardware Products and Documentation consistent with: (i) for acquisition by or on behalf of civilian agencies, 

the 

terms set forth in FAR12.212; or (ii) for acquisition by or on behalf of units of the Department of Defense, the 

terms set forth in DFARS 227.7202. Use of the Epiphan Hardware Products, Software and Documentation is 

further 

restricted by the terms and conditions of this Agreement and the applicable commercial purchase agreement for 

the Epiphan Hardware Products. For the purposes of any applicable government use, the Epiphan Hardware Products, 

Software and Documentation were developed exclusively at private expense, and are trade secrets of Epiphan 

System s Inc. for the purpose of any Freedom of Information legislation or any other disclosure statute, regulation or 

provision. 

13. Export Restrictions: The Epiphan Hardware Products, Software, Documentation and related information are 

subject to export and import restrictions. By downloading, installing, or using the Software, Epiphan Hardware 

Products, Documentation and/ or related information, You are representing and warranting that You are not 

located in, are not under the control of, and are not a national or resident of any country to which the export of the 

Epiphan Hardware Products, Software, Documentation and/ or related information would be prohibited by the 

laws and/ or 

regulations of Canada or the United States. You are also representing and warranting that You are not an 

individual to whom the export of the Epiphan Hardware Products, Software, Documentation or related information 

would be 

prohibited by the laws and/ or regulations of Canada or the United States. You shall comply with the export laws 

and regulations of Canada and the United States that are applicable to the Epiphan Hardware Products, Software, 

Documentation and related information and You shall also comply with any local laws and/ or regulations in 

Your jurisdiction that may impact Your right to export, import, or use the Epiphan Hardware Products, Software, 

Documentation or related information, and You represent and warrant that You have complied with any such 

applicable laws and/ or regulations. The Epiphan Hardware Products, Software, Documentation and related 
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information shall not be used for any purposes prohibited by export laws and/ or regulations, including, without 

limitation, nuclear, chemical, or biological weapons proliferation. You shall be responsible for procuring all required 

permissions for any subsequent export, import, or use of the Epiphan Hardware Products, Software, 

Documentation or related information. 

14. Intellectual Property: Epiphan, Epiphan System s and Epiphan Video are tradenames, trademarks or registered 

trademarks of Epiphan System s Inc. in certain countries. All Licensor product names and logos are trademarks or 

registered trademarks of Epiphan System s Inc. in certain countries. All other company and product names and 

logos are trademarks or registered trademarks of their respective owners in certain countries. You shall not 

disclose, 

transfer or otherwise provide to any third party any portion of the Software, except as expressly permitted in 

this Agreement. 

15. General: This Agreement is the entire agreement between You and Licensor in respect to the Software, 

superseding any other agreements or discussions, oral or written. The terms and conditions of this Agreement shall 

prevail over any pre-printed terms on any quotes, orders, purchase orders, or purchase order 

acknowledgements, and shall prevail over any other communications between the parties in relation to the 

Software. You may not assign this Agreement whether voluntarily, by operation of law, or otherwise without 

Licensor's prior written consent. 

Licensor may assign this Agreement at any time without notice. The failure of a party to claim a breach of any term of 
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this Agreement shall not constitute a waiver of such breach or the right of such party to enforce any subsequent 

breach of such term. If any provision of this Agreement is held to be unenforceable or illegal, such decision shall 

not affect the validity or enforceability of such provisions under other circumstances or the remaining provisions of 

this Agreement and such remaining provisions shall be reformed only to the extent necessary to make them 

enforceable under such circumstances. This Agreement shall be governed by the laws of the Province of Ontario and 

the laws of Canada applicable therein. No choice or conflict of laws rules of any jurisdiction shall apply to this 

Agreement. You shall only be entitled to bring any action or proceeding arising out of or relating to this 

Agreement, the Epiphan 

Hardware Products, Software, Documentation or any services provided in respect to the Epiphan Hardware 

Products, Software and/ or Documentation in a court in Ottawa, Ontario, Canada, and You consent to the 

jurisdiction of such courts for any such action or proceeding. You waive all rights that You may have or that may 

hereafter arise to contest the jurisdiction of such courts for any action or proceeding brought by You. You hereby 

waive any right You may have to request a jury trial with respect to any action brought by You in connection with 

this Agreement, the Epiphan 

Hardware Products or Software or any services provided in respect to the Epiphan Hardware Products or 

Software. The application of the United Nations Convention on Contracts for the International Sale of Goods to 

this Agreement is expressly excluded. 

 

 

Environmental   Information 

 

The equipment that you bought has required the extraction and use of natural resources for its production. It may 

contain hazardous substances that could impact health and the environment. In order to avoid the dissemination 

of those substances in our environment and to diminish the pressure on the natural resources, we encourage 

you to use the appropriate take-back systems. Those systems will reuse or recycle most of the materials of your 

end life equipment in a sound way. The crossed-out wheeled bin symbol invites you to use those systems. If you 

need more 

information about collection, reuse and recycling systems, please contact your local or regional waste 

administration. You can also contact us for more information on the environmental performance of our products. 

Important Safet y Warnings 

 

WARNING: This product has no user-serviceable parts and the battery used in this device is not replaceable. Do 

not attempt to disassemble. Return the device for service. 
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CAUTION, RISK OF ELECTRIC SHOCK: This device may have multiple AC power cords installed. All power sources 

shall be disconnected before servicing to avoid shock hazard. 

ATTENTION: Cet appareil ne contient aucun composant pouvant être entretenu ou réparé par l'utilisateur. En 

cas de panne, retourner l'appareil pour réparation. 

ATTENTION, RISQUE DE CHOC ÉLECTRIQUE: Cet appareil peut être équipé de multiples cordons d'alimentation en 

courant alternatif. Pour placer cet appareil hors tension, débrancher tous les cordons d'alimentation sans 

exception. 

FCC Compliance St atement 

 

47 CFR Section 2.1077 Compliance Information 

Unique identifier: SDI2USB 3.0 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

 

1. This device may not cause harmful interference 
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2. This device must accept any interference received, including interference that may cause undesired operation. 

Responsible party (US 

contact): Epiphan Video 

459 Hamilton Avenue, Suite 301 

Palo Alto, CA 

94301, USA 

 

www.Epiphan.com 

 

FCC CAUTION 

 

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s 

authority to operate the equipment. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 

part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 

in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not 

installed and used in accordance with the instructions, may cause harmful interference to radio communications. 

However, 

there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 

harmful interference to radio or television reception, which can be determined by turning the equipment off and 

on, the user is encouraged to try to correct the interference by one or more of the following measures: 

– Reorient or relocate the receiving antenna. 

 

– Increase the separation between the equipment and receiver. 

 

– Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

 

– Consult the dealer or an experienced radio/ TV technician for help. 

 

Innovation, Science and Economic Development Canada: 

 

This device complies with ICES-003 of the ISED rules. Operation is subject to the following two conditions: 

 

(1) This device may not cause harmful interference, and 

 

(2) this device must accept any interference received, including interference that may cause undesired operation. 

 

Cet appareil est conforme à la norme ISED NBM-003 pour les appareils radio agréés. Son fonctionnement est 

http://www.epiphan.com/
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sujet aux deux conditions suivantes: 

(1) le dispositif ne doit pas produire de brouillage préjudiciable, et 

 

(2) ce dispositif doit accepter tout brouillage reçu, y compris un brouillage susceptible de 

provoquer un fonctionnement indésirable. 

CE Compliance St atement 

Marking by the symbol  indicates compliance of this device with the applicable directives of the European 

Community and meets or exceeds the following technical standards: 

Directive 2014/ 30/ EU - Electrom agnetic Compatibility 
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Directive 2011/ 65/ EU - RoHS, restriction of the use of certain hazardous substances in electrical and 

electronic equipment 

 

 

 

 

Other Jurisdict ional Issues 

 

Epiphan makes no representation that its products or information in this document or its web site is appropriate or 

available for use in your jurisdiction. Those who choose to access the Epiphan web site or use Epiphan products do 

so on their own initiative and are responsible for compliance with local laws, if and to the extent local laws are 

applicable 

Subm issions to Epiphan and Affiliated Servers 

 

Any information, including but not limited to remarks, suggestions, ideas, graphics, or other submissions, 

communicated to Epiphan through their Epiphan web site is the exclusive property of Epiphan. Epiphan is entitled 

to use any information submitted for any purpose, without restriction (except as stated in Epiphan's Privacy 

Statem ent) or compensation to the person sending the submission. The user acknowledges the originality of any 

submission communicated to Epiphan and accepts responsibility for its accuracy, appropriateness, and legality. 

Third Parties and Links to Third-Party Web Sites 

 

Mention of non-Epiphan System s Inc. products or services on their website, or this document site is for 

informational purposes and does not constitute an endorsement or recommendation. 

This document may contain links to non-Epiphan web sites. These links are provided to you as a convenience, and 

Epiphan is not responsible for the content of any linked web site. Any outside web site accessed from the 

Epiphan web site is independent from Epiphan, and Epiphan has no control over the content of that web site. In 

addition, a link to any non-Epiphan web site does not imply that Epiphan endorses or accepts any responsibility 

for the content or use of such a web site. 

In no event shall any reference to any third party or third party product or service be construed as an approval or 

endorsement by Epiphan of that third party or of any product or service provided by a third party. 
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Miscellaneous 

 

It is the user's responsibility to ascertain whether any information downloaded from the Epiphan web site or 

other websites is free of viruses, worms, trojan horses, or other items of a potentially destructive nature. 

Enforcement of Terms and Conditions 

 

These Terms and Conditions for use of this document and the associated Epiphan Product are governed and 

interpreted pursuant to the laws of the province of Ontario, Canada, notwithstanding any principles of 

conflicts of law. 

All disputes arising out of or relating to these Terms and Conditions shall be finally resolved by arbitration 

conducted in the English language in Ottawa, Ontario, Canada under the commercial arbitration rules of the 

Canada. The parties shall appoint as sole arbitrator a retired judge who presided in the province of Ontario. The 

parties shall bear equally 
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the cost of the arbitration (except that the prevailing party shall be entitled to an award of reasonable attorneys' 

fees incurred in connection with the arbitration in such an amount as may be determined by the arbitrator). All 

decisions of the arbitrator shall be final and binding on both parties and enforceable in any court of competent 

jurisdiction. 

Notwithstanding this, application may be made to any court for a judicial acceptance of the award or order of 

enforcement. Notwithstanding the foregoing, Epiphan shall be entitled to seek injunctive relief, security, or 

other equitable remedies from any court of competent jurisdiction. 

If any part of these terms is unlawful, void, or unenforceable, that part will be deemed severable and will not 

affect the validity and enforceability of the remaining provisions. Epiphan may, at its sole discretion and 

without notice, 

revise these terms at any time by updating this posting. 

 

Copyright © 2018 Epiphan System s Inc. 

 

All Rights Reserved. 

 

© and ™2018, Epiphan Systems, Inc 


